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Bevezető 

 

Szeretnénk lépésről-lépésre, az alapoktól kezdve, a Word részeit és parancsait 

bemutatni. Segítséget és gyakorlati tanácsokat adni dokumentumok elkészítéséhez, amely 

iskolai óránkat, előadásunkat teheti érdekesebbé, élvezetesebbé. A Microsoft Word a 

Microsoft Office irodai programcsomag része. A munkánk megírásának alapjául a Word 

2010-es kiadása szolgált, amely a legelterjedtebb manapság a személyi 

számítógépeinken. A programot magyar nyelvre is lefordították. Munkánkban az angol és 

a magyar kifejezéseket is feltüntettük (mivel a magyar szakszavak a számítástechnikában 

még nem terjedtek el eléggé). 

A Microsoft Office programcsomag, a 2007-es kiadásától kezdődően, a 

hagyományosnak számító legördülő menüket Menüszalagokkal (Ribbon) helyettesítették, 

a jobb kezelhetőség érdekében. Az utasítások képek formájában (vagy kép és szöveg) 

jelentek meg, az „egy szó többet mond száz szónál” elvet követve, valamint csoportokat 

alkotnak. Ezen újítások mellett megjelent a Minipult (Mini Toolbar), amely a 

leggyakrabban használt utasításokat tartalmazza, és kijelölés vagy jobb klikkelés után 

válik láthatóvá. A 2007-es verziótól eltérően a 2010-es verzióban az Office gomb helyett 

újra a Fájl (File) felületen találjuk a kulcsfontosságú műveleteket (Mentés, Mentés 

másként, Megnyitás, Nyomtatás, Beállítások, stb.).  

 

A Microsoft Word 2010 lehetőségei az oktatásban 

 
A szövegszerkesztők számos lehetőséget nyújtanak az oktatásban, mind a tanárok, 

mind pedig a diákok számára. A tanulók az informatika óra keretében megismerkednek a 

szövegszerkesztés alapismereteivel, a szövegszerkesztő alkalmazás kezelésével. Az 

ismeretek gyakorlása, alkalmazása pedig más tárgyak óráival is összekapcsolhatók. A 

tanári munkában is sokat segíthet, ha tudjuk, hogyan és mire is használhatjuk a 

szövegszerkesztő programokat. A szövegszerkesztés alapvető ismereteinek és a 

szövegszerkesztő programok kezelésének elsajátítása után a szövegszerkesztő program 

tetszőleges tantárgyban felhasználható. 

 

A Microsoft Word hasznos segítőtársa lehet a gyakorló pedagógusnak a következőkben: 

 
 Iskolai dolgozatok, feladatsorok elkészítése  

 Oktatási segédanyagok készítése  

 Iskolai újság szerkesztése  

 Oklevelek elkészítése  

 Szórólapok, meghívók megtervezése és kivitelezése  

 Tantervek, tanmenetek elkészítése 

 
A szövegszerkesztő (Microsoft Word) programban a következő konkrét műveleteket 

tudjuk elvégezni: 

 

 Szövegek bevitele (gépeléssel, szövegdigitalizálással)  

 Szövegek egyszerű javítása, beszúrására, törlése  



 Szövegek formázása (betűk, szavak, mondatok, lapok, a teljes 

dokumentum) 

 Táblázatok használata  

 Tartalomjegyzékek és egyéb hivatkozások készítése 

 Grafikák, képek, rajzok beillesztése, elkészítése 

 A szöveg helyesírásának ellenőrzése, javítása 

 Körlevelek készítése és küldése  

 A kész dokumentum nyomtatása  

 Szövegek elmentése, visszatöltése 

 

 

Alapműveletek 
 

Futtatás 

 

A programot legegyszerűbben a Start menü All Programs > Microsoft Office > 

Microsoft Office Word 2010 parancsának segítségével futtathatjuk. Legtöbbször a Word 

parancsikon megtalálható az Asztalon is. 

 

1. kép 

Microsoft Word egyes verzióinak ikonjai (2003-as, 2007-es és 2010-es verzió) 

 

                 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



A programablak részei 

 

2. kép 

Microsoft Word programablak 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A Microsoft Word 2010 programablaka a következő részekből áll: 

 

1. Címsor (Title Bar) – A bal oldalán a Word ikon és a gyorselérésű eszköztár 

található, közepén a megnyitott dokumentum neve és a Microsoft Word felirat, a 

jobb oldalán pedig az ablakvezérlő gombok találhatók.  

2. Menüszalag (Ribbon) Az ablak címsora alatti menüben a PowerPoint 

menüszallagainak, valamint ezek füleinek listáját találjuk kategóriák szerint 

csoportosítva. A következő csoportok találhatóak meg itt: Fájl (File), Kezdőlap 

(Home), Beszúrás (Insert), Lap elrendezése (Page Layout), Hivatkozás 

(References), Levelezés (Mailings), Korrektúra (Review) és a Nézet (View).  

Folyamatosan látható gombként megtalálható (a jobb felső sarokban) A 

menüszalag összcsukása (Minimize the Ribbon), amely CTR + F1 

gombkombináció segítségével is megvalósul, valamint Segítség (Help), amely 

F1-es gombbal hívható elő. Ezen fülek mellett (az egyes elemekre duplán 

klikkelve) megjelenik a Formátum (Format) szalag, amely az aktuális elemek 

szerkesztési lehetőségeit kínálja fel. 

 



 

3. kép 

Formátum menüszalag (alakzatra alkalmazva) Segítség és a A menüszalag összcsukása 

gombokkal 

 

 

 

 

 

 

3. Vonalzó (Ruler) – Horizontális és vertikális vonalzó található a dokumentum 

felett, illetve a dokumentum bal oldalán. A vonalzón megjelennek, illetve át 

engedélyezhetők, a különböző beállítások mint például a behúzások és a 

tabulátorok. Emellett az egyes elemek méretét tudjuk itt figyelemmel követni. A 

vonalzó mérőszámai a beállítások függvényében változnak (hüvelyk, centiméter, 

milliméter, stb.). A vonalzó a Nézet (View) menüszalag Vonalzó (Ruler) 

jelölőnégyzetével jeleníthető meg vagy tüntethető el.  

4. Szerkesztőfelület – Ezen a részen történik szöveg szerkesztése, valamint itt 

látható az egyes műveleteink végeredménye, valamint a dokumentum. 

5. Gördítő Sáv (Scroll Bar) - ha az aktív dokumentum nem fér el az ablakban, a 

"kilógó" területeit a gördítő sávokkal tehetjük láthatóvá.  

6. Állapotsor (Status Bar) - az állapotsor bal oldalán látható a szerkesztett 

dokumentum oldalainak és szavainak száma, a helyesírás-ellenőrzés ikonja és a 

dokumentum nyelve. A jobb oldalán a nézetválasztás ikonjai találhatók. Itt 

válthatunk a dokumentum megjelenítési módjai közül. Választhatunk Nyomtatási 

elrendezés, Olvasás teljes képernyőn, Webes elrendezés, Vázlat és Piszkozat 

nézet közül. Ezek a parancsok, a további megjelenítést módosító parancsok 

mellett, a Nézet menüből is elérhetők. A dokumentum nagyítását módosító 

eszközök a programablak jobb alsó sarkában található. A plusz és mínusz jelekkel 

10%-os ugrásokat, a pontos nagyítási szint (Nagyítás párbeszédpanel) pedig az 

aktuális nagyításra (például: 100%) klikkelve tudjuk meghatározni.  

 

 

 

 

 

 

 

 

 

 

 

 

 



4. kép 

A Nagyítás párbeszédpanel 

 

 
 

 

Program beállításai 

 

 A program beállításai a következő elérési útvonalon érhető el: Fájl szalag, 

Beállítások opció File > Settings. Ezen a részen (a többi Office alkalmazáshoz 

hasonlóan) a program működésére vonatkozó beállításokat tudjuk módosítani, mint 

például a Minipult megjelenítése-eltüntetése, Színséma, mentésekre vonatkozó 

beállítások (alapértelmezett fájltípus, alapértelmezett mentési mappa, automatikus 

mentés),  a Menüszalag és a Gyorselérési eszköztár testre szabása. A menüszalag és a 

gyorselérési eszköztár testre szabható a jobb klikk segítségével megjelenített helyi 

menüből is.  

 A Nyelvi ellenőrzés (Proofing) opciónál lehetőségünk van beállítani az 

automatikus javításokat, a helyesírási és nyelvtani ellenőrzéseket.  

 

 

 

 

 

 

 

 

 

 



5. kép 

A Nyelvi ellenőrzés beállításai 

 

 
 

 

A Mentés (Saves) menüpont kiválasztása után, lehetőségünk van a mentésre 

vonatkozó beállításokat pontosítani. A Mentés fájltípusa (Save files in this format) 

legördülő menüből meghatározható a mentések alpértelmezett fájltípusa. Ez a fájltípus 

fog elsődlegesen megjelenni egy új dokumentum mentésénél (doc, docx, dot, dotx, rtf, 

htm, txt, stb. kiterjesztés választható). Ha meglévő dokumentumot szerkesztünk, akkor a 

program az eredeti fájltípusban folytatja a mentést (ha doc kiterjesztésű dokumentumot 

szerkesztünk, akkor a mentés is ebben a formátumban történik, függetlenül a beállított 

mentés fájltípusától).  

Az Automatikus helyreállítási adatok mentése (Save Autorecover 

information every) felületen egy igen hasznos segédeszköz beállításait tudjuk 

konfigurálni, amely elsődlegesen az adatvesztés ellen hatásos. A legkisebb beállítható 

időintervallum 1 perc. A mentés időpontjától az adatok az esetleges szoftverhiba 

(lefagyás), hardverhiba vagy áramszünet esetén is visszaállíthatók lesznek. A mentési 

folyamat teljesen automatikusan történik, egy kis floppy lemez jelenik meg az 

állapotsoron.  

A Fájlok alpértelmezett mappája (Default file location) beállítás pontosításánál 

az új dokumentumok mentésénél és a megnyitás kezdeményezésénél a beállított mappa 

fog megjelenni célkönyvtárként (ajánlott azt a mappát meghatározni, amelyben a 



szöveges dokumentumainkat tároljuk – például D:/+DOKUMENTUMOK). Ez a 

beállítást időt takarít meg a felhasználóknak a mentések és a megnyitások alkalmával. 

 

6. kép 

A Mentés beállításai 

 

 
 

A Speciális (Advanced) menüpont alatt a szoftver működésének részletesebb 

beállításai módosítható. Egyik gyakran használt opció ezen a panelen a Mérőszámok 

mértékegysége (Show measurements unit of), amelyen meghatározható a szoftverben 

megjelenő nagyságok mértékegysége (hüvelyk, milliméter, centiméter, pont, stb.). Ez az 

opció a panel közepén található. A beállított egység megjelenik a vonalzón, a 

behúzásoknál, a margóknál, valamint a táblázatok, képek és ábrák méreténél. 

 

 

 

 

 

 

 

 

 

 

 



6. kép 

A Speciális beállítások Mérőszámok mértékegysége lehetőségei 

 

 
 

 

Feladatok: 

1. Határozzuk meg a mentés fájltípusaként a doc kiterjesztést 

2. Engedélyezzünk 1 percenkénti automatikus mentést 

3. Határozzuk meg alapértelmezett mappaként azt a mappát, amelyben a 

gyakorlófeladatok vannak (C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes 

vagy a D:/ECDL/MODUL3) 

4. Módosítsuk a mérőszámok mértékegységét centiméterre 

 

Fájl szalag beállításai 

 

 A fájl szalag tartalmazza a kulcsfontoságú műveleteket. A szalag tartalma a 2007-

as Word szoftverekben az Office gomb alatt található meg. Ha átváltunk erre a szalagra, 

akkor a dokumentumra vonatkozó legfontosabb műveletek jelennek meg. 

 

Legutóbbiak 

 

 A Legutóbbiak (Recent) menüpontra klikkelve megjelennek a legutóbb 

megnyitott fájlok és ezek mappája. 

 



 

7. kép 

Fájl menüszallag (Legutóbbiak opció) 

 

 
 

 

A legutóbbiak listája jobb a jobb egérklikkre megjelenő helyi menüből 

szerkeszthető. 

 

8. kép 

Fájl menüszallag (Legutóbbiak opció) 

 

 
 

Új dokumentum létrehozása 

 

A program megnyitása után alpértelmezetten egy új dokumentum kerül 

létrehozásra. További új dokumentum létrehozásához legegyszerűbb a Fájl szalag Új 

parancsával hozható létre (File > New). Új dokumentum a Ctrl + N billentyűk egyidejű 

lenyomásával is létre tudunk hozni. Az opció engedélyezése után az új dokumentum 

kinézetét és elrendezését kell meghatározni. 



 

9. kép 

Fájl menüszalag (Új dokumentum) 

 

 
 

A leggyakrabban az Üres dokumentum (Blank document) pontot válasszuk, de 

hasznos lehet az új dokumentum létrehozása egy sablon felhasználásával is. A 

dokumentum típusának megfelelően tudunk választani a sablonok közül (levél, tervek, 

névjegykártyák, naptárak, meghívók, levelek, önéletrajzok, stb.). A megnyitott sablon 

módosításával gyorsan és hatékonyan készíthető el a kívánt dokumentum. 

A teljes dokumentumokra vonatkozó sablonok a Minta-sablonok (Sample 

templates) menüpont alatt található. Az alkalmazott sablon a Lap elrendezése (Page 

Layout) fülön a Témák (Themes) csoportnál megválasztható a teljes megjelenés, a 

sablon a színe, betűtípusa  és az effektusai.  

 

 

 

 

 

 



10. kép 

Fájl menüszalag (Új dokumentum) 

 

 

 

 
 

Feladatok: 

1. Próbáljunk ki néhány tetszőleges sablont Minta-sablonok csoportból 

2. Módosítsuk a felhasznált sablon tulajdonságait tetszőlegesen a Témák csoportban 

 

Mentés  

 

Az általunk szerkesztett dokumentumokat, ha nem csak nyomtatni akarjuk, hanem 

szeretnénk megőrizni és a későbbiekben szerkeszteni, akkor ajánlatos elmenteni a 

háttértárunkra. A dokumentumot nem csak a munka befejeztével, hanem a munka 

folyamatában is ajánlott menteni, azért hogy ne következzen be adatvesztés a váratlan 

hardver- és szoftverhibák, illetve az áramkimaradás esetén.  

A szöveges dokumentumunk mentéséhez használjuk a Fájl szalag Mentés 

parancsát (File > Save). A Ctrl + S gombkombinációval is mentést tudunk 

kezdeményezni. Ha a Mentés gombbal egy korábban már elmentett bemutató mentését 

kezdeményezzük, akkor az új változat automatikusan felülírja a bemutató korábbi 

példányát. Ha egy újonnan létrehozott bemutató mentését kezdeményezzük, akkor a 

megjelenő Mentés másként párbeszéd panelen meg kell határoznunk, hogy a bemutatót 

milyen néven, és melyik mappába mentjük. 

A Fájl (File) szalag Mentés másként (Save As) parancsának használatakor 

minden esetben lehetőségünk van a mentésre szánt bemutató nevét, valamint a célmappát 

megváltoztatni (gyorsgomb F12). Ebben az esetben a bemutató előző példánya a korábbi 

néven és helyen változatlanul megmarad. A Mentés másként panelen először határozzuk 

meg a célmappát Hely (Save in), majd a Fájlnév (File name) mezőben adjuk meg a 

bemutató nevét. A művelet befejezéséhez kattintsunk a Mentés (Save) gombra. 

A mentés másként ablakban a Fájltípus (File name) legördülő menüben 

kiválaszthatjuk a menteni kívánt dokumentum típusát.  

 

11. kép 

A Mentés másként panel 

 



 
 

 

1. táblázat 

Lehetséges mentések jellemzői a Word 2010-es szoftverben 

 

Név Kiterjesztés Leírás 

Word 97-2003 verziójú 

dokumentum 

(Word 97-2003 

Document) 

doc 

 

A 2003-as és a régebbi Word programok 

alapértelmezett állománya. Manapság 

kompatibilis mentésként alkalmazzák. Ha 

2007-es vagy 2010-es Office-ban 

szerkesztünk ilyen fájlokat, akkor a 

kompatibilis mód (Compatibility Mode) 

olvasható a programablak fejlécében a 

fájlnév mellett. 

Word-dokumentum  

(Word Document) 
docx 

A Microsoft Word 2007 és a 2010 

alapértelmezett fájlformátuma. Ezek a 

fájlok mentése ZIP tömörítés segítségéve 

történik, nemcsak kisebbek mint a  régebbi 

fájlok, de a megbízhatóság és az adatok 

helyreállításának lehetősége is javul. 

Word 97-2003 sablon 

Word 97-2003 template 
dot 

A sablonfájlok lehetőséget nyújtanak az 

egyes dokumentumok statikus (nem 

változó és többször használatos) 

elemeinek elmentésére. Kompatibilis 

mentéssel létrehozott fájl. 

Word-sablon dotx A sablonfájlok lehetőséget nyújtanak az 



Word template egyes dokumentumok statikus (nem 

változó és többször használatos) 

elemeinek elmentésére. 

Rich Text Format 

Rich Text formátum 
rtf 

Az rtf a "Rich Text Format" rövidítése, 

jelentése "gazdag szövegformátum". Egy 

kompatibilis fájlformátum, amelyet a 

Word szövegszerkesztő mellett más 

szoftverek is „felismernek”. Nagyobb 

fájlok mint a docx kiterjesztésűek. 

Plain Text 

Egyszerű szöveg 
txt 

A txt az angol „text”, azaz „szöveg” szó 

rövidítése. Ezek a fájlok csak karaktereket 

tudnak tárolni, formázás és egyéb grafikai 

elemek (képek, táblázatok, grafikonok) 

nélkül.  

 

Weblap 

Web Page 

 

html 

 

Az internetes világban rendkívül elterjedt 

fájlformátum, ez a weblapok alapnyelve. 

Szöveget, képeket, és sok egyebet 

tartalmazhat. Ha dokumentumunkat az 

interneten szeretnénk közzétenni, akkor 

ebben a formátumban kell elmenteni. 

Portable Document 

Format 
pdf 

Általában nem szerkeszthető, széles 

körben alkalmazott formátum. 

 

 

Fontos:  

 

 A 2007-es és a 2010-es fájlokat (docx, xlsx és pptx) a 2003-as Office programok 

nem tudják megnyitni. Ha olyan számítógépen szeretnénk megnyitni a 

dokumentumainkat, amelyen 2003-as Office van telepítve, akkor használjuk a 

kompatibils (97-2003) mentési módot (doc, xls és ppt fájlokat hozunk létre). 

a sablon. 

 Sablonok mentésénél (a mentési mód kiválasztása után) a PowerPoint átvált a 

sablonok tárolására fenntartott mappára (C:/Documents and Settings/User 

name/Application Data/Microsoft/Templates mappa alapértelmezetten) 

 

 

 

Feladatok: 

1. Nyissuk meg a (C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) az alap.doc dokumentumot 

2. Mentsük el a dokumentumot alap2007 névvel a Mentések almappába 

3. Mentsük el a dokumentumot html fájlba alap néven a Mentések almappába 

4. Mentsük el a dokumentumot dot fájlba alap néven a Mentések almappába 

5. Mentsük el a dokumentumot rtf fájlba alap néven a Mentések almappába 

6. Mentsük el a dokumentumot txt fájlba alap néven a Mentések almappába 



7. Figyeljük meg, hogy mi történt a képpel, és a szövegformázással a különböző 

mentéseknél, figyeljük meg a fájlok méretét 

 

Megnyitás  

 

A megnyitást az eszköztár ikonjával, a CTRL+O billentyűkombinációval, vagy a 

Fájl menü Megnyitás (File > Open) pontjával kezdeményezhetjük. Ekkor megjelenik 

egy állomány-kiválasztó párbeszédpanel, ahol kijelölhetjük, melyik dokumentumot 

szeretnénk megnyitni, majd az OK megnyomása után a megnyitás megtörténik, hatására 

a képernyőn megjelenik a dokumentum szövege. Az egyes dokumentumok megnyithatók 

az operációs rendszerből vagy fájlkezelő szoftverből is (Total Commander). 

 

12. kép 

A Megnyitás ablak 

  

 
  

 

Feladatok: 

1. Nyissuk meg a (C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) Mentések mappába került fájlokat a Megnyitás (Open) 

parancs segítségével, majd figyeljük meg, hogy a különböző mentések alkalmával mely 

adatok maradtak meg, illetve vesztek el (szövegformázás, kép, stb.) 

 

Bezárás  

 



Ha befejeztük a munkát, bezárhatjuk a bemutatót a Fájl szalag Bezárás 

utasításával (File > Close). Amennyiben a bemutató még nem mentett módosításokat 

tartalmaz, a Word felkínálja a mentés lehetőségét a következő tartalmú ablakban: Menti 

a(z) „dokumentumnév” dokumentum módosításait (Do you want to save the 

changes you made to „dokumentumnév”). Ha az Igen gombra kattintunk, a 

PowerPoint a Mentés parancs segítségével elmenti, majd bezárja a bemutatót. Az egyes 

dokumentumablakok a CTRL + W billentyűkombinációval zárhatók be. 

 

13. kép 

A bezárás előtt megjelenő ablak (ha a bemutató tartalmaz nem elmentett részeket) 

 

 
 

Kilépés  

 

A Fájl szalag Kilépés parancsával (File > Exit) vagy a bemutató ablakának 

bezárás gombjával (Alt + F4). A program itt is felkínálja mentést a még nem mentett 

dokumentumokra. A különbség a Bezárás és a Kilépés parancs között az, hogy a Kilépés 

parancs az összes megnyitott Word dokumentumnál kezdeményezi a bezárást, amíg a 

Bezárás csak az aktuális dokumentumot zárja be. 

 

Súgó  

 

A Súgó (Help) ablakban rákereshetünk a beállításokra, parancsokra és egyéb 

Word tartalmakra. A Súgó megjeleníthető a menüszalag végén található kérdőjelre 

klikkelve, a Fájl menüből és az F1 funkcióbillentyűvel. A Súgó kulcsszavakra jelenít meg 

találatokat (hasonlóan mint az operációs rendszer súgója), amelyeket a világhálóról 

kerülnek letöltésre. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

12. kép 

A Súgó ablak, a körlevél kulcsszóra kezdeményezett keresés után   

 

 

 
 

Oldalbeállís 

 

Ajánlott egy dokumentum szerkesztést az oldalbeállításokkal kezdeni. A 

különféle oldalbeállítási lehetőségeket a Lap elernedezése fül Oldalbeállítás 

csoportjában találjuk meg (Page Layout  > Page Setup). 



Az oldalbeállításra vonatkozó utasítások megtalálhatók az Oldalbeállítás (Page 

Setup) párbeszédpanelen is, amelyet a csoport jobb alsó sarkában található ikonnal 

tudunk megjeleníteni. 

 

 

13. kép 

Az Oldalbeállítások párbeszédpanel 

 

 
 

A Margók (Margins) alatt a szövegnek a lap széleitől vett távolságát értjük. A 

Margók legördülő menüjéből alkalmazhatjuk a felkínált margókat, illetve a legutóbb 

használt margók kerülnek ebbe a menübe. A részletesebb margóbeállítást az Egyéni 

margók (Custom Margins) érhetünk el, ilyenkor az Oldalbeállítás párbeszédablak 

jelenik meg. Ezen a panelen külön-külön is beállíthatjuk bal- és jobb oldalon (Left, 

Right), valamint az alsó és felső részeken (Bottom, Top). Ezen margók módosításával 

változik a szöveg és az egyéb tartalmak (képek, ábrák és grafikonok) helye az oldalon. 

A Kötésmargó (Gutter) a későbbiekben bekötendő dokumentumoknál az oldalak 

belső vagy felső részén automatikusan kimaradó sáv (amennyiben megadunk egy ilyen 

értéket) a bekötés esetére.  



 

Megjegyzés: a nyomtatók nagy részénél alapértelmezetten van egy minimális margó, 

tehát nem tudnak egészen a lap széléig nyomtatni. 

 

 

 

14. kép 

A Margók legördülő menü (az Oldalbeállítás előhívható az Egyéni margók menüponttal 

vagy a jobb alsó sarokban található ikonnal) 

 

 
 

A lap Tájolásánál (Orientation) meghatározhatunk Álló (Portrait) vagy Fekvő 

(Landscape) elrendezésű szöveges dokumentumot.  

 

 

 

 



 

 

 

 

 

15. kép 

Az oldal beállításai  

 

 
 

A Papírméretek (Paper) széles skálájából választhatunk. Ezek közül 

legelterjedtebb az A4-es méret. Ha legördülő menü nem tartalmazza a keresett méret, 

akkor a További papírméretek (More Paper Sizes) menüpont kiválasztása után 

megjelenő párbeszédablakban tudunk egyéni méreteket beállítani (párbeszédablak az 

Oldalbeállítás panel második füléről is elérhető).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

16. kép 

Az oldal beállításai  

 

 
 

 

A Lap elrendezése (Page Layout) szalagon található a Vízjel (Watermark), 

amely segítségével a sablonban felkínált vagy egyéni vízjeleket tudunk beszúrni. Akkor 

használatos a vízjel ha a dokumentum egyéni kezelést igényel (titkos, bizalmas, sürgős, 

stb.). Ugyanezen a szalagon található az Oldalszín (Page Colors) funkció, amely 

segítségével az oldal hátterét tudjuk megváltoztatni. 

 

Feladatok: 

1. Alkalmazzuk a következő oldalbeállítást: margók felső: 5,5 cm; alsó: 5,5 cm; bal:  4,0 

cm; jobb: 4,0 cm; Tájolás: Álló; Papírméret: A4. A dokumentum álljon két üres lapból. 

Mentsük el a dokumentumot az Asztalra papirmeret.doc név alatt. 



2. Alkalmazzuk Oladalbeallitasok.doc fájl oldalbeállításait a 

SzamitastechnikaiViccek.doc állományra 

(C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) 

3. Engedélyezzünk a dokumentumnak világoszöld hátteret 

4. Jelenítsük meg a dokumentum hátterére a „Nem másolható” feliratot Times New 

Roman 72-es betűtípussal, piros betűszínnel 

 

Vezérlő karakterek megjelenítése  

 

Minden dokumentum sok olyan szimbólumot tartalmaz, amely a nyomtatott 

dokumentumban nem jelenik meg. Ezeket nem nyomtatható karaktereknek vagy más 

néven vezérlő karaktereknek nevezzük. A legismertebb vezérlőkarakterek a tabulátor, 

szóköz és az Enter. A formázó karakterek megjelenítéséhez vagy elrejtéséhez használjuk 

a Kezdőlap szalag Mindent mutat (Show All) menüpontját.   

 

Feladatok: 

1. Nyissuk meg a D:/ECDL/MODUL3/Alap.doc fájlot, és jelenítsük meg a vezérlő 

karaktereket 

 

A kijelölés 

 

Szövegrészeket akkor tanácsos kijelölni, ha valamilyen műveletet az adott részre 

egyszerre szeretnénk elvégezni. Ilyen művelet lehet a másolás, mozgatás, törlés, a 

formátum beállítása, stb. A kijelölt szöveget az különbözteti meg a többitől, hogy 

világoskék keretet és kap.  

Vigyázat! Ha kijelölünk egy szövegrészt, és ha nem szüntetjük meg a kijelölést 

mielőtt elkezdünk gépelni, akkor az így újonnan begépelt szöveg felülírja az egész 

kijelölt szakaszt, azaz minden, ami az adott szakaszban volt, eltűnik. Lehetőség a 

visszaállításra: Visszavonás menüpont. A kijelölést úgy szűntethetjük meg, ha 

megnyomjuk valamelyik kurzormozgató billentyűt, vagy az egérrel a szöveg valamelyik 

pontjára kattintunk.  

A billentyűzettel történő kijelölés 

 

Ha lenyomva tartjuk a SHIFT billentyűt, és így mozgatjuk a kurzort, akkor a 

közbeeső terület kijelölődik. A kurzor mozgatására ilyenkor is mindazokat a billentyűket 

használhatjuk, amelyek az előző részekben szerepeltek. 

 

2. táblázat 

Kijelölés billentyűzet segítségével 

 

A kijelölt rész Művelet 

Egy betűvel jobbra SHIFT + jobbra-nyíl  

Egy betűvel balra SHIFT + balra-nyíl  

A szó végéig CONTROL + SHIFT + jobbra-nyíl  



A szó elejéig CONTROL + SHIFT + balra-nyíl  

A sor végéig SHIFT + END  

A sor elejéig SHIFT + HOME  

Az aktuális sor vagy a következő 

sor 
SHIFT + le-nyíl  

Az előző sor SHIFT + fel-nyíl  

A bekezdés végéig CONTROL + SHIFT + le-nyíl  

A bekezdés elejéig CONTROL + SHIFT + fel-nyíl  

Egy képernyőt lefele SHIFT + PAGE DOWN  

Egy képernyőt felfele SHIFT + PAGE UP  

A dokumentum végéig CONTROL + SHIFT + END  

A dokumentum elejéig CONTROL + SHIFT + HOME  

Teljes dokumentum kijelölése CONTROL + HOME, majd CONTROL + 

SHIFT + END  

Teljes dokumentum kijelölése CONTROL + A  

 

 Az egyik leggyakrabban használt gombkonbináció CTR + A, amellyel a 

dokumentum teljes tartalmát jelöljük ki. Ez a funkció működik az operációs rendszerben 

az ablakok tartalmára alkalmazva, illetve az egyéb szoftverek nagy részében használható. 

 

Az egér használatával történő kijelölés 

 

A Wordben lehetőségünk van egér segítségével is kijelölni tartalmakat a 3. 

táblázatban ismertetett módon.  

 

3. táblázat 

Kijelölések egér segítségével 

 

A kijelölt rész Művelet 

Szó  Duplán kattintsunk a szóra.  

Mondat  
Tartsuk lenyomva a CTRL billentyűt és kattintsunk bárhova a 

mondatban.  

Bekezdés  

Mozgassuk az egeret a bekezdés bal oldala felé addig, amíg az 

egérmutató meg nem változtatja az irányát, majd kattintsunk duplán, 

vagy háromszorosan bárhová a bekezdésben.  

Az egész 

dokumentum  

Mozgassuk az egeret a bármelyik dokumentumszöveg bal oldala felé 

addig, amíg az egérmutató meg nem változtatja az irányát, majd 

kattintsunk háromszorosan.  

Téglalap alakú 

szövegterület  

Tartsuk lenyomva az ALT billentyűt, majd húzzuk az egeret. 

Táblázatban nem használható.  

Grafikus 

objektum 
Kattintsunk a grafikus objektumra (kép, rajz, alakzat, diagram) 

 

Az egér segítségével történő kijelölés másik módja a Kijelölés (Select) legördülő 

menü használata, amely a Kezdőlap szalag jobb sarkában található meg. Az itt taláható 



utasítások közül a Hasonló formátumú szöveg kijelölése (Select All Text With Similar 

Formatting) utasítással az azonos formátumú szöveges részeket tudjuk kijelölni (először 

kijelöljük azt a szövegrészt, amellyel azonos formázású szöveget szeretnénk kijelölni). 

 

 

17. kép 

Az oldal beállításai  

 

 

 
Feladatok: 

1. Nyissuk meg a Kijeloles.doc fájlot 

(C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) 

2. Jelöljük ki a az első bekezdés első szavát 

3. Jelöljük ki az első bekezdés első mondatát 

4. Jelöljük ki az első bekezdést 

5. Jelöljük ki a második bekezdésben azokat a szövegrészeket, amelyekben az 1-es szám 

szerepel 

6. Jelöljük ki a képet 

7. Alkalmazzuk a Hasonló formátumú szöveg kijelölése műveletet az Alap.doc 

dokumentum félkövér szövegrészeire 

 

Műveletek a szövegrészekkel 

 

Szövegrészek másolása és mozgatása 

 

Szöveg másolásán azt értjük, hogy egy kijelölt szövegrészről a dokumentum egy 

másik pontján vagy egy másik dokumentumban másolatot készítünk. Ekkor az adott 

szakasz az eredeti helyén megmarad. Ha mozgatjuk a szöveget, akkor elmozdítjuk 

helyéről, azaz az adott szövegszakasz eredeti helyén megszűnik, és egy új helyen jelenik 

meg.  

Ezt megtehetjük a Fogd és vidd módszerrel, ha egy kijelölt szöveg területén 

megnyomjuk az egér bal gombját, és lenyomva tartva egy másik helyre húzzuk, majd ott 

elengedjük, akkor a kijelölt szöveget ilyen módon átmozgatjuk a másik helyre. Ezt a 

művelet közben az egérmutató alján levő szaggatott téglalap jelzi. Ha ezalatt a CTRL 

billentyűt lenyomva tartjuk, akkor nem mozgatás, hanem másolás történik. Ezt a téglalap 

alján levő + jel jelzi.  



A vágólap az operációs rendszerről tanultak szerint működik a Wordben is: olyan, 

mint egy zseb, amiben egyszerre csupán egy dolog fér el. Ha egy szövegrészt kivágunk a 

vágólapra (betesszük a zsebbe), akkor megszűnik az eredeti helyén, és a vágólapra kerül. 

Ha másoljuk a vágólapra, akkor úgy jelenik meg ott, hogy közben az eredeti helyén is 

megmarad. Ahova mozgatni vagy másolni szeretnénk a szöveget, ott egyszerűen a kurzor 

helyén beillesztjük a szöveget a vágólapról.  

 A kivágás-beillesztés műveletsorozat a mozgatásnak felel meg, a másolás-

beillesztés sorozat pedig a szövegmásolásnak.  

 A Kezdőlap szalag Vágólap (Clipboard) csoportján a találhatjuk a Kivágás 

(Cut), a Másolás (Copy), és a Beillesztés (Paste) menüpontokat, amelyekkel a fenti 

műveleteket elvégezhetjük. de használhatjuk a szokott billentyűkombinációkat is: CTRL 

+ C (másolás), CTRL + X (kivágás) és CTRL + V (beillesztés).  

 

18. kép 

A Vágólap csoport a Kezdőlap szalagon 

 

 
 

A Kivágás vagy a Másolás művelet után (akár másik programból vagy 

programablakból) lehetőségünk van különböző módon beilleszteni a vágólapra került 

tartalmat. Ezt segíti elő legördülő menüje, amely segítségével különböző formájú 

szövegként tudjuk beilleszteni a tartalmakat a vágólapról. Az egyik gyakran használt 

opció a Csak a szöveg megtartása (Keep Text Only), amely a harmadik ikon a 

legördülő menüben és egy A betű jelöli, amely segítségével úgy illesszük be a szöveget, 

hogy eltűnik az összes formázási beállítása (betűtípus, szín, linkek, stb.). 

 

19. kép 

A Vágólap csoport a Kezdőlap szalagon 

 

 

 
 



 

Feladatok: 

 

1. Nyissuk meg a D:/ECDL/MODUL3/Kijelölés/Kijeloles.doc fájlot 

2. Másoljuk az összes 1-es karaktert az első bekezdésbe 

3. Töröljük az összes 1-es karaktert a második bekezdésben 

4. Helyezzük át a 4-es karaktereket a kép fölé 

5. Helyezzük a képet a szöveg elé 

6. Keressünk szöveget a Microsoft Wordről a Wikipédián, a google segítségével, a 

következő keresőszavak felhasználásával (microsoft word wiki hu). Másoljuk a szöveg 

első bekezdését Beillesztés és Csak szöveg megtartása parancs segítségével. 

 

Formátummásoló  

 

Gyakran fordul elő, hogy egy meglévő formázási beállítást szeretnénk alkalmazni 

egy másik szövegrészre. Ahelyett, hogy az egyes formázási beállításokat egyenként 

alkalmaznánk az új szövegre (kiolvassuk-alkalmazzuk), ajánlott a Formátummásoló 

(Format Painter) művelet alkalmazása, amely a Kezdőlap szalag Vágólap csoportjába 

található meg.  

A másolni kívánt formázási beállítások kijelölése után (szöveg vagy akár egy 

karakter) klikkelünk az eszköztáron található ecsetre. Az utasítás alkalmazása után a 

formázási beállítások tárolódnak (a kurzor mellett ecset jelenik meg – ESC gombbal 

tűntethető el). Ezután a módosítani kívánt szöveget kell kijelölni, és ezzel alkalmazzuk az 

előzőleg rögzített formázási beállításokat. 

 

Feladatok: 

1. Másoljuk a FormazasMasolasa.doc dokumentumban a formázást, a minta alapján 

(C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) 

 

Szövegrészek törlése 

 

Ha kijelölünk egy szövegrészt, akkor azt a DELETE billentyűvel, kitörölhetjük. 

A karaktereket egyenként a BACKSPACE billentyűvel is törölhetjük. A DELETE a 

kurzortól jobbra, a BACKSPACE pedig a balra elhelyezkedő karaktert törli.  

 

A Visszavonás és a Mégis parancs használata  

 

A különböző műveleteink visszavonása a Visszavonás (Undo), ikonra  történő 

klikkeléssel történik meg. Az ikon megtalálható a gyorselérési eszköztáron, illetve a 

CTRL + Z billentyűkombináció segítségével érhetjük el ezt a parancsot.  

Ha azonban úgy ítéljük meg, hogy az elvégzett művelet helyes volt, akkor 

használjuk a Mégis (Redo) parancsot. Az ikon megtalálható a gyorselérési eszköztáron, 

illetve elérhető a CTRL + Y billentyűkombináció segítségével.  

Ha az ikon fölé mozgatjuk, és rövid ideig rajta hagyjuk a kurzort, akkor 

megjeleníti az utolsó művelet nevét (pl.: Visszavonás: Beírás). A lefelé mutató nyilak 



segítségével a legördülő menüből meghatározhatjuk pontosan, hogy pontosan meddig a 

műveletig kívánjuk visszavonni a szerkesztést. 

 

Feladatok: 

1. Próbáljuk ki a visszavonás, és mégis parancsot a szövegbevitel során 

 

Szavak száma 

 

Hasznos segédeszköz lehet a Szavak száma (Word Count) parancs, ha olyan 

dokumentumot kell létrehozni/szerkeszteni, amelynél meghatározott a terjedelem 

(karakterek száma). A parancs elérhető az Állapotsorról (A szavak száma - Words 

részre klikkelve) vagy Korrektúra (Review) panelről. A parancs segítségével meg 

tudjuk jeleníteni a szöveg következő jellemzőit: Oldalak száma (Pages), Szavak száma 

(Words), Karakterek száma (szóköz nélkül) (Characters (no spaces)), Karakterek 

száma (szóközökkel) (Characters (with spaces)), Bekezdések száma (Paragraphs), 

Sorok száma (Lines). A Szövegdobozokkal, lábjegyzetekkel és végjegyzetekkel 

együtt (Include textboxes, footnotes and endnotes) jelölőnégyzet segítségével 

hozzáadhatjuk (elvehetjük) a lábjegyzeteket és végjegyzeteket.  

 

20. kép 

Szavak száma panel 

 

 
 

 

Feladatok: 

1. Nyissuk meg a Alap.doc dokumentumot 

(C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) 

2. Jelenítsük meg a szavak számát, ebben a dokumentumban Lábjegyzetek és 

végjegyzetek nélkül 

3. Jelenítsük meg a szavak számát, ebben a dokumentumban Lábjegyzetekkel és 

végjegyzetekkel együtt 

 

Szöveg keresése és cseréje 

 



Szöveg keresése 

 

Ha a szöveges dokumentumunkban szeretnénk egy adott szövegrészt, szót vagy 

karaktert megkeresni, akkor nem kell „gyalog” átnézni a szöveget, hanem használhatjuk a 

Word keresési funkciót. Ezt a funkciót a Kezdőlap szalag Keresés (Find) parancsára 

mutatva, vagy a CTRL + F billentyűkombinációval tudjuk elérni. A Keresett szöveg 

(Find what) mezőbe kell beírni a keresett szöveget. Az ENTER lenyomásával vagy a 

Következő (Find Next) gombra klikkelve, egyenként megjelenik a keresett szöveg a 

dokumentumban, kijelölve. 

 Ha szeretnénk a keresett szöveget tartósan kijelölni (alapértelmezetten 

citromsárga kerettel), akkor a Keresés és csere (Find and Replace) ablakban a Keresett 

szöveg beírása után a A Kiemelés olvasáshoz (Reading Highlight) gomb legördülő 

menüjéből Az összes kiemelése (Highlight All) menüpontot kell választani. A kijelölés 

után a szoftver megjeleníti a kiemelt szavak számát. A kijelölés megszüntetésére a 

Kiemelés megszüntetése (Clear Highlighting) paranccsal történik, amely ugyanebben a 

menüben található. 

 

21. kép 

Keresés és csere párbeszédablak 

  

 
 

Szövegben vagy dokumentumban történő keresésnél keresőoperátorokat is 

használhatunk. Például a „?” keresőoperátor tetszőleges karakter helyett szerepelhet; 

„k?t” keresése esetén az eredmény „két” és „kút” lehet. A „*” operátor tetszőleges számú 

karaktert helyettesíthet. Példáúl a „k*t” eredméye lehet a „két”, a „kút”, de a „kellett” és 

„kommunikálhatott” is. A keresőkarakter alkalmazását a Keresés és csere  panel 

Egyebek (More) eszközeit megjelenítve a Behelyettesítéssel (Use wildcards) 

jelölőnégyzet engedélyezésével kapcsoljuk be. 

 

 

 

 

 

 



 

 

 

 

 

 

22. kép 

A Keresés és csere párbeszédablak a megjelenített Egyebek beállításokkal 

 

 
 

Szöveg cseréje 

 

Ha egy szöveget egy másikra szeretnénk cserélni (pl.: következetesen hibáztunk 

az egész szövegben), akkor nem kell egyenként cserélgetni a szövegben, hanem 

használhatjuk a Word szöveg cseréje funkcióját.  Ezt a funkciót a Kezdőlap szalag Csere 

(Replace) parancsára mutatva, vagy a CTRL + H billentyűkombinációval tudjuk elérni, 

valamint a Keresés és csere panelről a Csere (Replace) fülre klikkelve. A Keresett 

szöveg (Find what) mezőbe írjuk be azt a szöveget, amelyet cserélni szeretnénk, a Csere 

erre (Replace with) mezőbe pedig azt a szöveget, amelyre szeretnénk cserélni. Ha 

egyesével szeretnénk cserélni, akkor a Csere (Replace) gombra klikkeljünk, ha pedig az 

összest szeretnénk egyszerre kicserélni, akkor pedig válasszuk Az összes cseréje 

(Replace All) opciót. 

 

 

 

 

 

 



 

 

 

 

 

 

23. kép 

Szöveg cseréje panel 

 

 

 
 

A keresésnél és cserénél (alapértelmezetten) nem tesz a szoftver különbséget a kis 

és nagybetűk között. Ha ezt engedélyezni szeretnénk, akkor ezt az Egyebek panelen 

található Kis- és nagybetűk megkülönböztetése (Match case) jelölőnégyzettel tudjuk 

megtenni. 

 

Ugrás a szövegben 

 

A szövegben történő lapozás a kurzorgombok mellett a Page Up és Page Down 

nyomógombokkal is megvalósulhat. Ha tudjuk, hogy a keresett tartalom melyik oldalon 

található, gyakran használjuk az Ugrás (Go To) parancsot. Ezt a funkciót a CTRL + G 

billentyűkombinációval tudjuk elérni, valamint a Keresés és csere panelről a Ugrás 

(Replace) fülre klikkelve. A mezőbe a pontos oldalszámot vagy relatív elmozdulást 

adhatunk meg  (+6 vagy -9 oldal). Az oldalakon kívül objektumokra, élőfejekre, 

lábjegyzetekre, stb. tudunk ugrani. 

 

 

 



 

 

 

 

 

 

24. kép 

Szöveg cseréje panel 

 

 
 

Feladatok: 

1. Nyissuk meg az Alap.doc dokumentumot 

(C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából) 
2. Keressük meg, hogy hányszor szerepel a szövegben a „2003” szám 

3. Gépeljük át az els  „Vord” szavat „Word” szóra 

4. Végezzünk el egy olyan keresést, amely találatként jeleníti meg a „Vord” és a „Word” 

szavakat is 

5. Definiáljunk egy olyan keresést, amely találatként megjelenít minden olyan szavat, amely „p” 

betűvel kezdődik és „t” betűvel végződik  

6. Nyissunk meg egy új dokumentumot, írjuk az első sorába az „Internet” szavat, majd másoljuk 

le háromszor a szavat. A Csere funkció segítségével cseréljük az „Internet” szavakat „internet” 

szóra 

7. Nyissuk meg az Evesjelentes.doc dokumentumot, majd ugorjunk az 3. oldalára az 

Ugrás paranccsal 
8. Próbáljuk ki a relatív elmozdulás parancsait is 

 

Szöveg begépelése 

 

  A begépelendő szöveg helyét egy függőleges, villogó vonal jelöli, amelyet 

kurzornak nevezünk. A kurzor mindig a képernyőnek azon a részén helyezkedik el, ahol 

a dokumentumot szerkeszthetjük. A kurzor szerepe az, hogy megmutassa a szövegnek azt 

a pontját, ahol a gépelési és szerkesztési műveletek hatása érvényesülni fog. 

Alaphelyzetben a beírt szöveg a kurzor helyére kerül, így az a kurzortól jobbra lévő 

szöveget maga előtt tolja.   



  Az írógépeknél minden sor végén nekünk kellett kezdeményezni az új sor 

megnyitását, azaz megnyomni a kocsivissza gombot, itt azonban a Word automatikusan 

tördeli a sorokat, tehát egy-egy bekezdés begépelése közben nekünk már nem kell sort 

váltanunk. Amint a sor végére érünk a gépeléssel, a szövegszerkesztő automatikusan a 

következő sor elején folytatja a szöveget. Egy bekezdés végének és egy új elejének 

jelzéséhez nyomjuk meg az Enter-t. A kurzor ilyenkor a következő sor elejére ugrik. Ha 

a bekezdésen belül szeretnénk sort váltani, bár még nem értünk a sor végére, akkor 

nyomjuk meg a Shift + Enter billentyűkombinációt.  

 

 Nagybetűk írására a következő lehetőségeink vannak: 

 

1. A nagybetűk folyamatos írására a Caps Lock billentyűt használjuk, amely 

kapcsolóként működik. Egyszeri megnyomása után csak nagybetűket fogunk írni, újra 

megnyomva pedig kikapcsoljuk a nagybetűk írását. A Caps Lock bekapcsolását egy 

lámpa jelzi a billentyűzeten. 

 

2. Csak néhány nagybetű beírásához a Shift (váltó) billentyűt használjuk. Tartsuk 

folyamatosan lenyomva a Shift billentyűt, majd írjuk be azokat a betűket, amelyeket 

nagybetűként szeretnénk leírni.  

 

3. Az Insert gomb lenyomásával a felülírás funkciót engedélyezzük, amikor is a 

kurzortól jobbra található szövegrészeket a szöveg bevitele letöröl. A funkció az Insert 

gomb újbóli lenyomásával szüntethető meg. 

 

  Ha egy billentyűn több karakter is szerepel, a következőképpen használhatjuk 

azokat. A billentyűkön látható felső karakterek beírásához nyomjuk le, és tartsuk 

lenyomva a Shift billentyűt, majd nyomjuk meg a leírni kívánt írásjelhez tartózó 

billentyűt.  

A jobb oldali numerikus billentyűzetről a számokat a Num Lock bekapcsolt 

állapota esetén (ezt egy világító lámpa jelzi) használhatjuk, kikapcsolt állapotban pedig a 

számok alatt levő funkciók érhetőek el. 

 

4. táblázat 

A szöveg begépelésekor használható billentyűkombinációk 

   

A kijelölt rész Művelet 

Egy karakterrel balra balra-nyíl  

Egy karakterrel jobbra jobbra-nyíl  

Egy szóval balra CONTROL + balra-nyíl 

Egy szóval jobbra CONTROL + jobbra-nyíl  

Sor végére  END  

Sor elejére HOME  

Aktuális bekezdés elejére CONTROL + fel-nyíl  

Következő bekezdés elejére CONTROL + le-nyíl  

Egy sorral lejjebb le-nyíl  

Egy sorral feljebb fel-nyíl  



Egy képernyőoldallal feljebb PAGE UP  

Egy képernyőoldallal lejjebb PAGE DOWN  

Előző lap tetejére CONTROL + PAGE UP  

Következő lap tetejére CONTROL + PAGE DOWN  

Dokumentum elejére CONTROL + HOME  

Dokumentum végére CONTROL + END  

 

Feladatok: 

1. Gépeljük be a következő adatokat saját magunkról: vezeték- és utónév, születési idő, 

születési hely, befejezett iskolák, munkahelyek. Mentsük el ezeket az adatokat a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a D:/ECDL/MODUL3 

mappába „Adatokrolam” név alatt, sablonként (az egységes részeket). 

2. Nyissuk meg az elmentett sablont, majd fejezzük be a dokumentum elkészítését 

(vigyük be saját adatainkat) 

 

Karakterformázás 

 

Bizonyos tulajdonságokkal minden egyes karaktert külön-külön felruházhatunk. 

Ezek a formázási beállítások főleg a szöveg bizonyos részeinek kiemelését szolgálják. 

Ahhoz, hogy ezeket a beállításokat elvégezhessük, előbb ki kell jelölni a megfelelő 

szövegrészt, majd az abban levő karakterek fognak módosulni.  

A karakterformázásokat a Kezdőlap szalag Betűtípus (Font) csoportjának 

segítségével tudjuk elvégezni. 

 

25. kép 

Betűtípus csoport funkciói 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

A Betűtípus (Font) kiválasztásával a szöveg megjelenési alakját határozzuk meg. 

Minden betűtípusnak saját neve van, amely azonosítja: pl. a Times New Roman, Arial, 

Courier New, Tahoma, Algerian, Verdana, Garamond, Trebuchet 
betűtípusok, amelyeket minden Windows rendszer tartalmaz. Ha a szöveg egy olyan 

betűtípussal íródott, amely nincs telepítve a számítógépünkre, akkor ezt egy hozzá 

hasonló betűtípussal helyettesíti a Word. Néhány betűtípus nem tartalmaz magyar 

karaktereket, ezeket a betűket szintén egy hasonló betűtípus karakterereivel helyettesíti a 

szoftver. 

A betűk nagyságát nyomdai mértékegységben, pontban határozhatjuk meg. Egy 

pont 1/72 hüvelyk, azaz kb. 0,35 mm. Az újságok általában 8-9, a könyvek 10, a rövidebb 

kiadványok, levelek pedig 12 vagy 14 pontos betűvel készülnek. A betűk nagyságát a 

Betűméret (Font Size) legördülő menüből tudjuk meghatározni, illetve Nagyobb 

betűméret (Grow Font) és a Kisebb betűméret (Shrink Font) ikonokkal tudjuk 

meghatározni. 

A Change Case (Kisbetű-nagybetű) funkcióval szövegrészeket tudunk 

átalakítani, betűnagyságot változtatni. A következő funkciókat tudjuk itt elérni: 

Mondatkezdő nagybetűk (Sentence case.), kisbetűs (lowercase), NAGYBETŰS 

(UPPERCASE), Szókezdő Nagybetűk (Capitalize Each Word), kICSI éS nAGY 

cSERÉJE (tOGGLE cASE). A funkciót egy kijelölt szövegrészre vagy szövegre tudjuk 

alkalmazni.  

 

26. kép 

Kisbetű-nagybetű parancs eszközei 

 

 
 

 

Formázás törlése (Clear Formating) parancs segítségével az alkalmazott 

formázási beállításokat tudjuk semlegesíteni. 



A betűstílusok közül megkülönböztetünk Félkövér (Bold), Dőlt (Italic), 

Aláhúzott (Underline). A félövér betűket a címek vagy szavak nyomatékosítására, a dőlt 

betűket idézésként használjuk.  

 

 

 

 

5. táblázat 

További karakterformázások gyorsbillentyűk segítségével 

 

Betűtípus Billentyűkombináció 

Félkövér (Bold) CTRL + B  

Dőlt (Italic) CTRL + I  

Aláhúzott szöveg (Underline) CTRL + U 

 

 

Az aláhúzott szövegrész is figyelemfelhívó jelleggel bír, bár manapság ez a hatás 

egyre inkább a hipertexteknek (linkeknek) fenntartott formázási mód. Az aláhúzás típusát 

és színét az aláhúzás eszköze mellett található legördülő menüből tudjuk kiválasztani. 

 

27. kép 

Betűtípus csoport funkciói 

 

 
 

A Betűtípus eszköztáron az említett eszközök megtalálható az Áthúzott 

(Striketrough) hatás, amely a különböző szöveges munkák javításánál lehet hasznos 

segédeszköz. Emellett az Alsó index (Subscript) felhasználható kémiai képleteknél 



(H2SO4), valamint Felső index (Superscript), amely főképp matematika képleteknél 

hasznos segédeszköz (3X
2
,
©

). 

Szövegeffektusok (Text Effects) eszköz segítségével a szövegre tudunk 

különböző hatásokat engedélyezni, a felkínált sablonok vagy egyéni beállítás 

segítségével. Ez az eszköz docx kiterjesztésű fájlok esetében működik, kompatibilis 

módban nem használható. 

 

 

28. kép 

Szövegeffektus csoport funkciói 

 

 
 

Szövegkiemelő szín (Text Highlight Color) eszközzel az egyes szövegek 

közvetlen hátterét tudjuk meghatározni. 

 

29. kép 

Szövegkiemelő szín parancs eszközei 

 

 



 
 

 

A karakterek színét a Betűszín (Font color) tudjuk meghatározni utasítással 

tudjuk meghatározni. Alapértelmezés szerint a karakterek színe Automatikus 

(Automatic), ami azt jelenti, hogy a Word az operációs rendszer alapértelmezett 

betűszínét (ez legtöbbször fekete) alkalmazza, ha a háttér 80%-osnál nem sötétebb (ekkor 

az automatikus szín a fehér). 

 

30. kép 

Betűszín parancs eszközei 

 

 
 

 

A további (részletesebb) karakterformázásokat a Betűtípus (Font) helyi menüből 

engedélyezhető. Itt megtalálható az összes karakterformázási hatás, amelyek hatésa a 

Minta (Preview) ablakban látható (a kijelölt szövegre alkalmazva). 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

31. kép 

Betűtípus párbeszédablak 

 

 
 

 

Az Árnyékolt (Shadow), Körvonalas (Outline), Domború (Emboss) és a 

Vésett (Engrave) hatások a nagyobb méretű szövegeken látható jól.  



 

6. táblázat 

További karakterformázások a Betűtípus panelen 

 

Megnevezés Használhatjuk Példa 

Áthúzott (Striketrough) munkák javításánál helytelen 
Kétszer áthúzott (Double striketrough) munkák javításánál helytelen 
Felső index (Superscript) matematika képletek x

2
 

Alsó index (Subscript) kémiai képletek H2O 
Árnyékolt (Shadow) szövegrészek kiemelésére sszzöövveeggrréésszz  
Körvonalas (Outline) szövegrészek kiemelésére 

Domború (Emboss) szövegrészek kiemelésére ssszzzööövvveeegggrrréééssszzz   

Vésett (Engrave) szövegrészek kiemelésére ssszzzööövvveeegggrrréééssszzz   

Kiskapitális (Small Caps) alcímek kiemelésére ALCÍM 
Nagybetűs (All Caps) címek kiemelésére CÍM 

Rejtett (Hidden) szöveg elrejtésére 
 

 

 

Feladatok: 

1. Végezzük el a Szovegformazas.doc dokumentumban a szövegformázásokat a minta 

alapján (a C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a 

D:/ECDL/MODUL3 mappából). 

2. Nyissuk meg a Adatokrolam.doc állományt. Engedélyezzünk az egész dokumentumra 

Arial betűtípust. Az egységes adatokatra engedélyezzük Arial 14-es, félkövér betűtípust, 

szürke háttérrel és piros betűszínnel. Az egyes személyekre vonatkozó adatokat 

formázzuk Arial 12-es, dőlt betűtípusra, citromsárga háttérrel. 

3. Nyissuk meg a BillGates.doc dokumentumot. Alkalmazzunk az egész szövegre Times 

New Roman 12 betűtípust. 

4. Próbáljuk ki a Kisbetű-nagybetű egyes funkcióit egy tetszőleges szövegre alkalmazva. 

 

Térköz és pozíció 

 



A Betűtípus párbeszédablak Speciális fülén (Font > Advanced)  panelen 

lehetőségünk van a betűk elhelyezkedésének, megjelenésének módosítására a Térköz és 

pozíció (Character Spacing) rész alatt. Lehetőségeink:  

 

 a betűk nyújtása vagy zsugorítása vízszintesen  

 a betűköz ritkítása vagy sűrítése  

 a betűk elhelyezkedése az alapvonaltól számítva lehet süllyesztett vagy emelt  

 

 

 

 

 

 

 

 

32. kép 

Térköz és pozíció panel 

 

 
 

 

Feladatok: 



1. Végezzük el a Terkoz.doc dokumentumban a szövegformázásokat a minta alapján (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából). 

 

Bekezdésformázás 

 

A karakterek után a következő nagyobb, önállóan formázható egység a bekezdés. 

A bekezdés két ENTER közötti szövegrész. Egy meglévő bekezdés lezárása, és egy új 

létrehozása az ENTER megnyomásával történik. Az ENTER megnyomása után a kurzor 

a következő sor elejére ugrik. A bekezdés végét a Word egy bekezdés vége karakterrel 

jelöli. A formázó karakterek a nyomtatott szövegben nem jelennek meg.  

A következő formázási lehetőségek a bekezdések egészére vonatkoznak, tehát 

nem szükséges karaktereket kijelölnünk, hanem arra a bekezdésre vonatkoznak a 

beállítások, amelyben a kurzor elhelyezkedik. Természetesen amennyiben több 

bekezdésre is egyszerre szeretnénk bizonyos formázási műveleteket elvégezni, úgy a 

kívánt bekezdések kijelölése válik szükségessé. 

 

A szöveg igazítása 

 

Alapértelmezés szerint, ha a szövegszerkesztővel írunk egy szöveget (vagy egy 

írógéppel), akkor a szöveg bal oldala mindig ugyanazon a függőleges pozíción kezdődik, 

jobb oldala azonban nem feltétlenül, így a szöveg jobb széle egyenetlenné, cikk-cakkossá 

válhat. Ezt a szövegmegjelenítési módot nevezzük Szöveg balra igazítása (Align Text 

Left), mivel a begépelt szövegnek a bal oldala az, amelyik egyenesre ki van igazítva. A 

dokumentumok formázásánál balra igazítjuk a megnevezést (személy vagy szervezet 

akinek a levél íródik), valamint az alcímeket is. 

 

A Középre zárás (Center) általában címek vagy megszólírások esetében használjuk.  

 

Bizonyos esetekben szükséges lehet A szöveg jobbra igazítása (Align Text Right) a 

szöveget, például aláírások esetében. 

 

Természetesen esztétikusabb, ha a szövegnek a bal oldala és a jobb oldala is egyenes, 

azaz függőleges irányban a sorok kezdete és vége is egy vonalban helyezkedik el. Ez úgy 

érhető el, ha a rövidebb sorok szavai közötti szóközöket némileg megnöveljük. Ennek az 

igazítási módnak a neve Sorkizárás (Justify). 

 

33. kép 

A szöveg igazítását meghatározó gombok 

 

Az ikonok mellett, a szöveg igazítása megvalósulhat gyorsgombok segítségével 

is. 



 

7. táblázat 

Az igazításhoz szükséges közvetlen billentyűparancsok  

 

Betűtípus Billentyűkombináció 

Balra igazítás CONTROL + L 

Középre igazítás CONTROL + E 

Jobbra igazítás CONTROL + R 

Középre igazítás CONTROL + J 

 

 

Feladatok: 

1. Formázzuk az EvesJelentes.doc szövegét (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a D:/ECDL/MODUL3 

mappából). a következő módon: címek: Jelentés készítője Akinek készül – balra igazított, 

Times New Roman 12, Italic; Munka címe: középre igazított, Times New Roman 24, 

Bold;  Dátum, helység – középre igazított, Times New Roman 12. Címek – Középre 

igazított, Times New Roman 14, Bold; Alcímek: Balra igazított, Times New Roman 12, 

Underline; Szövegtörzs – Középre igazított, Times New Roman 11. 

 

Behúzások 

 

A horizontális és a vertikális távolságokat helytelen helyköz (space), illetve 

enterek felvételével létrehozni. A horizontális távolságoknál behúzásokat, a vertikális 

távolságoknál pedig térközöket alkalmazunk. A behúzás azt jelenti, hogy meghatározzuk, 

milyen szélesek legyenek a bekezdések, azaz a normálishoz képest a bal- illetve jobb 

szélük esetleg mennyire térjen el. Különlegesen hasznos lehet még az első sor 

behúzásának külön kezelése, amelyet bekezdésenként esztétikai szempontból gyakran 

megteszünk. A behúzások módosíthatók a Kezdőlap szalagról, a Behúzás csökkentése 

(Decrease Indent) és Behúzás növelése (Increase Indent) ikonok segítségével. 

 

33. kép 

Behúzás csökkentése és Behúzás növelése ikonok 

 

 
 

 

Behúzásokat a Tabulátor (Tab) billentyűvel is létre tudunk hozni, amely 

alapértelmezetten 1,25 cm-vel húzza be a szöveget. Ez a billentyű a Q gomb mellett 

található. 

 

34. kép 

A Tabulátor helyzete a billentyűzeten 

 



 
 

 A tabulátor mellett a behúzások beállíthatók a vonalzón található Első sor 

behúzása (First Line Indent), Bal oldali behúzás (Left Indent) és Jobb oldali 

behúzás (Right Indent). 

35. kép 

A behúzások helyzete a vonalzón 

 

 
 

 

Dupla klikkel a fenn bemutatott elemekre a Bekezdés (Paragraph) 

párbeszédablakban a részletes beállítások adhatók meg. 

 

36. kép 

Bekezdés párbeszédablak 

 



 

 

 

Tabulátorok használata 

 

A Tabulátorok (Tabs) olyan eszköz, amellyel egy soron vagy bekezdésen belül a 

szöveget megadott pozícióba tudjuk igazítani. A tabulátorok létrehozása a vonalzóra 

történő klikkeléssel történik. 

 

37. kép 

A tabulátor megjelenítése a vonalzón 

 

 
 

 

 

 

 

A Tabulátorok részletesebb szerkesztése az egyes tabulátorokra történő dupla 

klikkeléssel megjelenő Tabulátorok párbeszédablakban lehetséges. 

 



38. kép 

Tabulátorok panel 

 

 
 

 

Feladatok: 

1. Hozzunk létre behúzásokat a EvesJelentes.doc szövegében az egyes bekezdéseknél (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a D:/ECDL/MODUL3 

mappából). 

2. A kezdőlap első két sorára (Jelentés készítője, Akinek készül) alkalmazzuk 2 cm-es 

behúzást 

 

Sor- és Térköz 

 

A Sor- és belezdésköz (Line and Paragraph Spacing) utasítás a Kezdőlap 

szalagon található és sorok és bekezdések közötti távolság állítható be itt. A 

dokumentumok döntő többségénél a szimpla sorköz a használatos. 

 

39. kép 

A Sor- és bekezdésköz lehetséges beállításai 

 

 



 
 

A Sorközbeállítások (Line Spacing Options) menüpont segítségével a Bekezdés 

párbeszédablak Behúzás és térköz füle nyílik meg (36. kép), ahol a behúzások, a 

sorköz és a térköz részletesebb beállításai találhatók meg. Az eszköztár mellett, a 

sorközök módosíthatók gyorsgombok segítségével is. 

 

8. táblázat 

A sorközök meghatározásához szükséges közvetlen billentyűparancsok  

 

Betűtípus Billentyűkombináció 

Szimpla sorköz CONTROL + 1 

Másfeles sorköz CONTROL + 5 

Dupla sorköz CONTROL + 2 

 

 

 

 

Az egyes sorok és bekezdések előtt és után található távolságot a Lap elrendezés 

(Page Layout) szalag Térköz (Spacing) funkciójával tudjuk beállítani. 

 

40. kép 

A térköz beállításai 

 



 
 

Feladatok: 

 

1. Engedélyezzünk az egész EvesJelentes.doc dokumentum szövegére szimpla sorközt (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a D:/ECDL/MODUL3 

mappából)  

2. Igazítsuk a EvesJelentes.doc dokumentum első oldalát a Bekezdések utasításaival 

úgy, hogy az első két sor fel, a munka címe a lap közepére, az utolsó két sor pedig a lap 

aljára kerüljön 

 

Stílusok használata és saját stílusok létrehozása 

 

Amikor több oldalas dokumentumot készítünk (szemináriumi munka, 

beszámolók), ahol jelentkeznek főcímek, alcímek és az alcímektől alacsonyabb rendű 

címek is, valamint különböző szöveg, akkor ezek következetes formázása már nagyobb 

munkát jelenthet. Ezt a munkát könnyíti meg a különböző stílusok alkalmazása. 

A Stílusok (Styles) munkaablakját a Kezdőlap szalagon található. A stílusok 

részletesebb megjelenítése az eszköztár jobb alsó sarkában található  - ikon segítségével 

jeleníthető meg. A meglévő stílusokat a szöveg kijelölése után az adot stílus nevére 

klikkelve tudjuk engedélyezni. 

 

 

 

 

 

 

 

 

 

 

 

 

41. kép 

A Stílusok megnevezését és beállításait tartalmazó munkaablak 

 



 
 

Ha meglévő stílus beállításait szeretnénk módosítani, akkor a stílus nevére 

klikkelve, a helyi menüből a Stílus módosítása (Modify) menüpontra klikkelve tehetjük 

ezt meg. A stílusok legfontosabb jellemzői: betűtípus, betűméret, stílus, a szöveg 

igazítása, a szöveg előtti és utáni térköz. 

 

 

 

 

 

 

 

 

 

 

 

42. kép 

Stílus létrehozása formázás alapján párbeszédablak 

 



 
 

Lehetőség van új stílusok létrehozására is. Ebben az esetben a stílusok 

eszköztáron az Új stílus (New Style) gombra kell klikkelni (az ablak bal alsó sarkában 

található), majd a Stílus létrehozása formázás alapján (Create New Style from 

Formating) párbeszédablakban meg kell határozni az újonnan létrejött stílus jellemzőit 

(a Stílus létrehozása formázás alapján ablak szinte teljesen megegyezik a 42-as képen 

látható ablakkal). Miután elfogadtuk az új stílust, megjelenik a stílusok között és a 

továbbiakban alkalmazni is tudjuk. 

 

Feladatok: 

1. Nyissuk meg a BillGates.doc fájlot (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából). Alkalmazzuk a főcímre Heading 1 

stílust. 

2. Módosítsuk a Heading 1 stílust úgy, hogy középre igazított legyen, majd alkalmazzuk 

újra.  

3. Hozzunk létre egy stílust alcím névvel (Times New Roman 12, Underline, Center, 6pt 

térköz), majd allkalmazzuk ezt a stílust az alcímekre a BillGates.doc dokumentumban. 

 

 

 

Formázása törlése 

 



A Stílusok a Egyebek résznél található a Formázás törlése (Clear Formatting) 

opciót választva a stílusok közül, megszüntetjük az összes alkalmazott formázást, és 

visszaállítjuk a szöveget alapértelmezett formázásba (az eszköz megtalálható a Kezdőlap 

szalagon is). 

 

43. kép 

Stílus létrehozása formázás alapján párbeszédablak 

 

 
 

Egyéb Word eszközök (oldalszámozás, felsorolások, szegély, iniciálé) 

 

Oldalszámozás beszúrása 

 

Az oldalakszámozást a Beszúrás szalagon az Oldalszám parancsot választva 

(Insert > Page Number) tudjuk kezdeményezni, ezután a felkínált minták közül kell 

meghatározni az oldalszám típusát és helyzetét.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

43. kép 

Oldalszámozás beszúrása 



 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Az első oldalra vonatkozó oldalszámozást (kerüljön-e számozás a címoldalra) az 

oldalszámozás beszúrása után megjelenő Tervezés (Design) szalagon található Első 

oldal eltérő (Different First Page) jelölőnégyzettel módosítható. 



 

44. kép 

Az oldalszámozás eltüntetése az első oldalról 

 

Az oldalszámozás a későbbiekben is szerkeszthető lesz (igazítható, módosítható, 

átméretezhető). Az oldalszámozás módosításait az oldalszámozásra történő dupla 

klikkeléssel is módosítani tudjuk. 

 

Feladatok: 

1. Szúrjunk be oldalszámozást a BillGates.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából) dokumentumba úgy, hogy az 

oldalszám a jobb alsó sarokba kerüljön, valamint hogy az első oldalra ne kerüljön 

oldalszám 

Felsorolások és számozások alkalmazása 

A felsorolásjeles vagy számozott lista áttekinthetőbbé, tagoltabbá teszi a szöveget.  

A felsorolás nem más, mint felsorolásjellel, számmal vagy más szimbólummal 

ellátott lista, amely az esetek többségében behúzással ellátottak. A felsorolási lista elemei 

kiválasztása után a Felsorolás (Bullets) funkció legördülő menüjéből tudunk különböző 

stílusú felsorolásokat létrehozni. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

45. kép 

Az felsorolások listajeleinek a beállítása 

 



 
 

 Egyes esetekben szükséges lehet egyes listák tagjainak a megszámozása. Ezt a 

műveletet a Felsorolás mellett található Számozás (Numbering) parancs legördülő 

menüjéből tudjuk kezdeményezni. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

46. kép 

A számozott lista lehetőségei 

 



 
 

A többszintű lista elemei allistálat is tartalmaznak, amely számozásas ennek 

függvényében módosul (például: 1., 1.1., 1.1.1., 2., 2.1., 2.1.1.). Az eszköz a Számozás 

parancs mellett található és Többszintű lista (Multilevel List) a neve. A legördülő 

menüből kell kiválasztani a megfelelő számozást. 

 

 

 

 

 

 

 

47. kép 

A számozott lista lehetőségei 

 



 
 

A Többszintű lista elfogadása után az egyes elemek Behúzásának növelésével 

vagy Behúzás csökkentésével igazítjuk a megfelelő helyre. 

A lista elemeinek törlése a BACKSPACE segítségével történek, új elemeket 

pedig ENTER nyomógombbal tudjuk felvenni. Törlés vagy új tag felvételével a 

számozás is a változik, illetve az új tag a megfelelő számozással jön létre. 

 

Feladatok: 

1. Tüntessük el a felesleges felsorolásjeleket és számozásokat a EvesJelentes.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  dokumentumban (Főcím2-Alcím2, 

Alcím3)  

2. Számozzuk a Felhasznált irodalom egyes elemeit a EvesJelentes.doc dokumentumban 



3. Végezzük el a Szövegformázás/Felsorolások.doc dokumentumban a felsorolások 

szerkesztését a minta alapján 

 

Szegély és mintázat  

 

A szövegeket bekeretezéssel díszíthetjük, illetve különíthetjük el a dokumentum 

többi részétől. A legegyszerűbb bekeretezés a Kezdőlap szalagról valósul meg a Szegély 

és mintázat (Borders and Shading) funkció használatával. A bekeretezés mellett a 

legördülő menüből részletesebb beállításokat is tudunk kezdeményezni. A körbehatárolt 

részek színezése az Árnyékolás (Shading) eszközzel valósul meg, amely a Szegély és 

mintázat művelet előtt található meg (Festékeskanna). 

 

48. kép 

Az Árnyékolás eszköz és a hozzá tartozó menü 

 

Feladatok: 

1. Engedélyezzünk körvonalat az Evesjelentes.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  első oldalára, valamint a címére. 

Alkalmazzunk szürke kitöltőszínt. 

 

Iniciálé  

 

Iniciálénak nevezzük a nagyobb, és díszesebb kezdőbetűt, amelyet a középkorban 

használtak nagy szeretettel (pl.: lexikonok). A Wordben is létrehozhatunk iniciálét a 

Beszúrás szalag Iniciálé parancsával (Insert > Drop Cap). A bekezdés első betűje így 

átkerül egy új keretbe, amelynek helyzete a szöveghez képest lehet: Süllyesztett 

(Dropped) - szöveggel körbefutatott vagy a Margón (In margin) álló.  

 

49. kép 

Az Árnyékolás eszköz és a hozzá tartozó menü 

 



 
 

Az Iniciálé beállításai (Drop Cap Options) párbeszédablakban megadhatjuk 

továbbá az iniciálé betűtípusát, méretét és a szöveg szélétől mért távolságát. Az iniciálé 

eltávolításához kattintsunk a bekezdésbe, majd válasszuk az Iniciálé menü Nincs (None) 

parancsát, vagy jelöljük ki az iniciálét tartalmazó keretet, majd nyomjuk meg a DELETE 

gombot. A bekezdés első betűjét ebben az esetben újra be kell gépelnünk.  

 

50. kép 

Az Iniciálé beállításai 

 

 

Feladatok: 

1. Hozzunk létre iniciálét a EvesJelentes.doc dokumentumban (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából), minden főcím első betűjére, a 

szövegbe süllyesztve, 6 sornyi mélységben 

 



Tartalomjegyzék létrehozása 

 

A tartalomjegyzék a dokumentum adott szintű címeit sorolja fel, és megadja 

oldalszámukat. Amikor tartalomjegyzéket állítunk össze, akkor a Word megkeresi az 

adott stílusú bekezdéseket, címszint szerint rendezi ezeket, beírja az oldalszámot, és 

megjelenteti a tartalomjegyzéket a dokumentumban.  

A tartalomjegyzék tetszőleges stílusú bekezdésekből felépíthető, de készítésének 

legegyszerűbb módja az, hogy a dokumentum címeit a beépített címstílusokkal 

formázzuk, amelyet a Hivatkozás (References) szalagon a Tartalomjegyzék (Table of 

Contents) részen tudunk elvégezni. 

 

51. kép 

A Hivatkozás szalag Tartalomjegyzék csoportja 

 

 
 

A tartalomjegyzék létrehozásának első lépése az, hogy meghatározzuk azokat a 

címeket és alcímeket, amelyeket a tartalomjegyzéket fogják alkotni. Az elemek kijelölése 

után az Új szöveg (Add Text) legördülő menüjéből a főcímek és alcímek Szintjét 

(Level) kell meghatározni (például: 1. szint – főcímek, 2. szint – címek, 3. szint - 

alcímek) egy elképzelt ranglétrán.   

 

52. kép 

A szintek meghatározása 

 

 
 

 

Ezután kattintsunk a dokumentumban arra a helyre, ahol a tartalomjegyzéket el 

szeretnénk helyezni, majd válasszuk a Tartalom (Table of Contents) elemei közül a 

megfelelő tartalomjegyzéket (ajánlott az első választása). 

 

 

 

53. kép 

Tartalomjegyzék beszúrása 

 



 
 

Gyakran előfordul, hogy egy dokumentumban, amelyben már megtalálható a 

tartalomjegyzék, módosításokat végzünk (új oldalakat írunk, új címek kerülnek felvételre, 

stb.). Ezen elemek a tartalomjegyzékhez történő hozzáadása nem történik meg 

automatikusan, a frissítést kezdeményezni kell. Ez a művelet elérhető a tartalomjegyzék 

felső részéből Frissítés (Update Table), a tartalomjegyzék helyi menüjéből 

Mezőfrissítés (Update field), illetve a tartalomjegyzék kijelölése után az F9-es 

nyomógombbal. A frissítés kezdeményezése után meg kell határozni, hogy Csak az 

oldalszámokat frissítése (Update page numbers only) vagy a Teljes jegyzék frissítése 

(Update entire table) történjen meg. Ha új címeket vettünk fel, akkor szükséges a teljes 

jegyzék frissítése, ha azonban az oldalszámok változtak, akkor elegendő a csak az 

oldalszámok frissítése opció is. 

 

54. kép 

Tartalomjegyzék frissítése 

 



 
 

 

Feladatok: 

1. Hozzunk létre egy tetszőleges dokumentumban főcímeket, címet és alcímeket más-más 

oldalra. Készítsünk ezekből tartalomjegyzéket. 

2. Hozzunk létre három szintes tartalomjegyzéket a második oldalra az EvesJelentes.doc  

(a C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  dokumentumban (főcímek, alcímek, 

alcímek alcímei) 

 

Körlevél készítése (Mail Merge) 

 

 Ha egy Word dokumentumot (meghívó, beszámoló, értesítés) több címre 

szeretnénk eljuttatni, akkor ahelyett hogy az összes dokumentumot külön-külön 

címeznénk és elmentenénk, ajánlott a Word Körlevél (Mail Merge) funkciójának a 

használata. A körlevél lényege, hogy szétválasszuk és külön fájlba 

(törzsdokumentumba) őrizzük azokat a dokumentumelemeket, amelyek változatlanok 

maradnak a dokumentumban (a meghívó szövege), valamint egy másik fájlba 

(adatforrás) tároljuk a változó adatokat (a címzettek adatait). Az adatforrás létrehozása 

az első körlevélnél vesz igénybe több időt, de később (a később alkalmazásoknál) a 

befektetett idő többszörösen megtérül. Ajánlott minden célcsoporthoz külön címlistát 

készíteni (szülők, meghívottak, tanácstagok, stb.), amelyeket egységesen tudunk a 

későbbiekben alkalmazni. 

 A körlevél készítésének első lépése az, hogy létrehozunk egy új dokumentumot, 

amelyben megszerkesszük a körlevél statikus elemeit, amely minden levélben ugyanaz 

lesz (meghívó szövege). Ezután elmentjük a dokumentumot (törzsdokumentum). 

 A következő lépésben elkészítjük az adatforrás fájlot, amelyben megtalálhatóak 

lesznek azok az adatok, amelyek változnak minden egyes levélnél (címzett neve, címe 

stb.). Ezeket az adatokat táblázatokba kell rendezni, és a táblázat első sorába kerülnek a 

különböző adatok megnevezései. A megszerkesztése után elmentjük ezta dokmentumot 

is. 

 

 

 

 

 

9. táblázat 

Egy adatforrás dokumentum tartalma 

 



Címzett Helység Utca, házszám Irányítószám 

Máté Béla Kishegyes Lenin utca 24321 

Zsoldos Róbert Szabadka Szép utca 24000 

Máray Katalin Szabadka Szegedi út 24000 

Harmat Imre Bajsa Kis utca 24331 

 

 Miután elkészítettük a törzsdokumentumot és az adatforrást, a 

törzsdokumentumot nyitjuk meg, és elkezdjük a két dokumentum összekapcsolását, úgy 

hogy Levelezés (Mailings) szalagról a Körlevél indítása (Start Mail Merge) legördülő 

menüjéből a Lépésenkénti körlevélvarázsló (Step by Step Mail Merge Wizard) 

funkcióra klikkelünk. 

 

55. kép 

Lépésenkénti Körlevélkészítés indítása 

 

  
 

 

A funkció indítása után a jobb oldalon egy munkaablak jelenik meg, amelyben 

elvégezhetjük a körlevél elkészítéséhez szükséges hat lépést. 

Az első lépésben ki kell választani a dokumentum típusát. Leggyakrabban a Levél 

(Letter) vagy az E-mail (E-mail messages) opciót válasszuk, majd a Tovább (Next) 

szövegre klikkelünk, a munkaablak alsó részén (a továbbiakban egy hagyományos levél 

formájú körlevél elkészítését ismertetjük). 

A második lépésben a körlevél alapjaként szolgáló dokumentumot kell 

kiválasztani. Ez a dokumentum a megnyitott törzsdokumentum, tehát az Aktuális 

dokumentum alapján (Use current document) lehetőséget kell választani 

(alapértelmezett opció). Ezután a Tovább linkkel tudunk a következő lépésre áttérni. 

Minden egyes lépésnél az Előző (Previous) szövegre klikkelve tudunk egy lépést vissza 

lépni.  

A harmadik lépésnél kell a két dokumentumot összefűzni úgy, a címzetteket egy 

Létező listából (Use an existing list) válasszuk ki (marad alapértelmezetten), majd a 

Tallózás (Browse) szövegre klikkelve, megnyitjuk az adatforrás fájlt.  

 



56. kép 

Lépésenkénti Körlevélkészítés első három lépése 

 

 
 

 Az adatforrás megnyitása után a címzetteket rendezni, szűrni, esetleg egyeseket 

törölni tudunk a listáról (a jelölés eltávolításával a jelölőnégyzetből). A módosítások 

elvégzése után az OK gombra klikkelve fogadjuk el a listát.  

 

 

 

 

 

57. kép 

A címzettek módosítására szolgáló párbeszédablak 

 



 
 

A negyedik lépésben beillesszük az adatforrás egyes részeit a dokumentumba 

(akár többször is). Meghatározzuk, hogy hova fog kerülni a címzett, a megszóllítás, a cím 

stb. Ennek a folyamatnak az első lépéseként meg kell határozni ezen kategóriák helyét (a 

kurzor pozicionálásával).  Majd a munkaablakban látható További elemek (More items) 

kiválasztása után meghatározzuk, hogy a kategóriák közül melyiket kívánjuk beilleszteni. 

A beillesztés a Beszúrás (Insert) paranccsal történik meg. Az újabb elemeket az ablak 

bezárása után, a művelet újrakezdésével tudjuk megtenni (További elemek). Az 

beillesztett elemek egyelőre zárójelben fognak a szövegben szerepelni (például: 

<<Címzett>>).  

  

 

 

 

 

 

 

 

 

 

58. kép 

A negyedik lépésben megjelenő munkaablak és az Adatmező beszúrása ablak 

 



 
 

Az ötödik lépésben az elkészült leveleket tudjuk megtekinteni (a kategóriák 

behelyettesítésre kerülnek). Az egyes levelek közötti ugrást a munkaablakban vagy a 

Levelezés szalagon található nyilak segítségével tudjuk megtenni.   

 

 

 

 

 

 

 

 

 

59. kép 

A levelek megtekintése 

 



 
 

 A hatodik lépésben történik meg a dokumentumok egyesítésének a befejezése. Az 

utolsó lépésben a Nyomtatás (Print), az Egyes levelek szerkesztése (Edit individual 

letters), illetve e-mail esetében a levelek kiküldése történik meg. Az Egyes levelek 

szerkesztése paranccsal egy új dokumentumba egyesítsük a Törzsdokumentumot és a 

Címlistát, így lehetőség nyílik az egyes levelek szerkesztésére is. A parancs kiválasztása 

után az Egyesítés új dokumentumba (Merge to New Document)  párbeszédablak 

jelenik meg, ahol legtöbbször a Mind (All) opcióval egy új dokumentumba kerülnek 

másolásra a level. 

 

 

 

 

60. kép 

Egyesítés új dokumentumba 

 



 
 

   

 A művelet elvégzése után mentsük el a fájlokat. Ezután a Törzsdokumentum 

bezárása, majd újra megnyitása után egy értesítés kapunk, amely a fájlok közötti 

kapcsolatot jelzi. A körlevél megtekintése az Igen parancs engedélyezésével valósul meg 

(ezen értesítés megjelenésével tudhatjuk meg, hogy a körlevél készítése sikeres volt és a 

két dokumentum egyesítése megtörtént).  

 

61. kép 

A Törzsdokumentum megnyitásánál megjelenő értesítés 

 

 
 

Feladatok: 

1. Hozzunk létre körlevelet úgy, hogy a Korlevel/Torzsdokumentum.doc lesz a 

törzsdokumentum a Korlevel/Cimlista.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  lesz a címlista (egyesítsük a két 

dokumentumot) 

2. Készítsünk el egy meghívót egy megbeszélésre, valamint az ehhez tartozó címlistát a 

következő elemekkel: vezetéknév, keresztnév, titulus, cím, település. Egyesítsük a két 

dokumentumot. 

 

 

 

Táblázatok 

 

Táblázat létrehozása 



 

 A táblázatokat különböző adatok szemléltetésére használjuk (órarendek, 

beosztások, mérések adatai stb). A táblázat legkisebb különálló része a Cella (Cell). Az 

egymás alatt található cellák neve Oszlop (Column), az egymás mellett található cellák, 

pedig neve pedig Sor (Row). 

 A táblázatok létrehozása a Beszúrás (Insert) szalagról a Táblázat (Table) 

legördülő menüből történik. A létrehozás megtörténhet egérhúzással (a cellák számának a 

behúzásával). 

 

62. kép 

Táblázat létrehozása egérhúzással 

 

 
 

 

A létrehozás másik módja, ha a Táblázat beszúrása (Insert Table) menüpontra 

klikkelünk, majd a megjelenő párbeszédablakban meghatározzuk a táblázat 

tulajdonságait. 

 

63. kép 

A Táblázat behúzása parancs után megjelenő párbeszédablak 

 

 

 

 



 
 

 A táblázat létrehozható még rajzolással, Excel táblázat importálásával és kész 

táblázatok (sablon) kiválasztásával. 

 

 

Táblázat celláinak kijelölése 

 

 Az egész táblázat kijelölése legegyszerűbben a kijelölés után a bal felső sarokban 

megjelenő keresztre klikkelve lehetséges. Az oszlopok, illetve a sorok kijelölése az 

oszlop és a sor első cellájának a határvonalára klikkelve (a kurzor átvált fekete nyillá) 

valósul meg. 

 

64. kép 

A teljes táblázat, az oszlop és a sor kijelölésénél megjelenő kurzor 

 

     
 

 

Táblázat celláinak módosítása  

 

A táblázat celláinak a méretét tudjuk változtatni úgy, hogy az egeret a módosítani 

kívánt rész fölé húzzuk, megvárjuk, hogy a kurzor megváltozzon, majd áthúzással 

engedélyezzük az új méretet. Ha a határolóvonalra klikkelünk duplán, akkor a sor vagy 

az oszlop mérete úgy módosul, hogy látható legyen a leghosszabb tartalom is.  

Ha meghatározott értékekre szeretnénk igazítani egy táblázat (oszlop vagy sor) 

dimenzióit, akkor a módosítani kívánt kijelölt cellatartomány helyi menüjéből a Táblázat 

tulajdonságai (Table Properties) pontot választva a Sor (Row) illetve az Oszlop 

(Column) fülön tudjuk a méretét tudjuk meghatározni (mértékegységben vagy 

százalékos arányban). 

 

 

 



65. kép 

Táblázat tulajdonságai 

 

 
 

A helyi menüből elérhető funkciók 

 

 A táblázat módosítását eredményező legtöbb funkciók megtalálhatóak a táblázat 

helyi menüjében. A cellák vagy cellacsoportok kijelölése után a helyi menüből elérhetőek 

a kivágás, a másolás és a beillesztés funkció. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



66. kép 

Táblázat helyi menüje a megjelenített Beszúrás és Cellaigazítás lehetőségekkel 

 

 
 

 A táblázat elemei (cellák, sorok és oszlopok), a szöveghez hasonlóan, 

másolhatóak és kivághatóak. 

 Oszlopok, illetve sorok beszúrásához, ezek kijelölése után az Oszlopok 

beszúrása (Insert Columns) vagy a Sorok beszúrása (Insert Rows) menüponttol 

vesszük fel az új elemeket. A helyi menüből meghatározható, hogy a kijelölt részhez 

viszonyítva melyik irányba kerüljenek felvételre az új cellák (sorok és oszlopok).  

Az egyes esetekben (például a táblázat címének a meghatározásánál), szükség van 

a cellák egyesítésére. Ezt a cellatartomány kijelölésére után a kijelölt felület helyi menüre 

klikkelve a Cellák egyesítése (Merge Cells) végezzük el ezt a műveletet. Az egyesítéssel 

ellenkező művelet a Cellák felosztása (Split Cells). A művelet engedélyezése után meg 

kell határozni, hogy hány cellára bontsuk fel a kérdéses cellatartományt. 

A cellák tartalmát horizontális és vertikális irányba is igazítani tudjuk. A 

Cellaigazítás (Cell Alignment) a helyi menüből érhető el, amely kilenc lehetséges 

helyzetet kínál fel. 

 

Táblázat tulajdonságai  

 

A táblázat további szerkesztése a kijelölés után megjelenő Tervezés (Design) 

szalagon lehetséges. Itt Táblázatstílusok (Table Styles) eszközzel előre definiált 

stílusokat tudunk alkalmazni. A táblázat tulajdonságai egyénileg is meghatározható az 

Árnyékolás (Shadding) eszközzel színezni tudjuk az egyes cellákat. A vonal stílusának 

vastagságának és színének a beállítása után az egyes vonalak módosítása a Szegélyek 

(Borders) legördülő menüjéből választható ki az alkalmazásra kerülő vonalak. 

 

 

 



67. kép 

Tervezés szalag (táblázatra alkalmazva) 

 

 

Táblázat celláinak megszámozása  

 

Jelöljük ki azokat a cellákat, amelyeket meg szeretnénk számozni. Kattintsunk az 

eszköztáron a Számozás (Numbering) gombra. 

 

Feladatok: 

1. Hozzunk létre egy táblázatot, amelybe a későbbiekben órarendet tudunk szerkeszteni 

(6x7). Az első sor legyen egy cella, amelynek fekete háttere és fehér felirat címe. Az első 

oszlop (órák sorszámai) legyen 1 cm széles. A táblázat körvonala legyen 3-as vastagságú 

kék vonal, a belső vonalak pedig legyenek 1-es vastagságú, szaggatott piros vonalak.  

 

Képek beszúrása 

 

A Word a szövegen kívül grafikus objektumokat  is meg tud jeleníteni. Ezeket 

vagy más programból másoljuk, vagy a Beszúrás szalag Kép parancsa kiválasztása után 

tudjuk megjeleníteni (Insert > Picture). A kép beszúrása mellett lehetséges a következő 

grafikai objektumok beszúrása ClipArt (Clipart) és Alakzatok (Shape). 

A beszúrt képeket a bekezdések igazítására szolgáló elemekkel tudjuk igazítani.  

A beszúrt képet a Formátum (Format) szalagon tudjuk módosítani, ahol képkorrekciót 

tudunk végezni, át tudjuk színezni, valamint képstílusokat tudunk választani. A 

Formátum eszköz a képet kijelölve jelenik, illetve a képre történő kettős klikkelés után. 

 

68. kép 

Formátum szalag első része 

 

 

 

 

 

 

 A Szöveg körbefuttatása (Wrap text) eszközzel a kép és a szöveg közötti 

viszonyt tudjuk meghatározni. A Körülvágás (Crop) eszközzel a kép egyes elemeit 

tudjuk levágni. A kép mérete a Méret (Size) csoportnál határozható meg (ügyeljünk a 

mértékegységre). 

 

 

 

 



69. kép 

Formátum szalag második része 

 

 
 

Kép szerkesztése (Format picture) párbeszédablak segítségével további 

szerkesztési elemek érhetők el. Az ablak a képre alkalmazott helyi menüből érhető el. 

 

70. kép 

Kép formázása 

 

 



 

 

Feladatok: 

1. Mozgassuk a képet különböző módon (behúzás, tabulátor, helyköz) 

2. Szúrjuk be a Grb_subotice.jpg képet a EvesJelentes.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  dokumentumba első oldalára. A kép 

magassága legyen 3 cm, igazítsuk középre a képet. 

3. Próbáljuk ki a Körülvágás funkciót egy tetszőleges képen 

 

Fedőlap beszúrása 

 

 A szerkesztett dokumentum fedőlapjának gyors és látványos hozzáadása a 

Beszúrás szalag Fedőlap (Cover Page) legördülő menüből lehetséges. Az újonnan 

hozzáadott kezdőlapok többsége felveszi a dokumentum alapvető adatait (a dokumentum 

neve, felhasználónév), de ezek a szöveges felületek módosíthatók is. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



71. kép 

Fedőlap beszúrása 

 

 
 

 

1. Engedélyezzünk tetszőleges fedőlapot az alap.doc fájlra (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  

 

Dátum és idő beszúrása 

 

A Beszúrás szalag Dátum és idő (Insert > Date & Time) parancsa segítségével 

tudjuk megjeleníteni az aktuális dátumot és időt. A párbeszédablakban a megfelelő Nyelv 

(Language) kiválasztása segít a megfelelő dátumformátum kiválasztásában. Jelöljük be 

az Automatikus frissítés (Update automatically) jelölőnégyzetet, ha azt szeretnénk, 

hogy az idő vagy dátum a dokumentum megnyitásakor vagy kinyomtatásakor 

automatikusan frissüljön.  

 



 

 

 

72. kép 

Dátum és idő  beszúrása 

 

 
 

Feladatok: 

1. Szúrjuk be a mai dátumot az EvesJelentes.doc dokumentum (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  első oldalára 

2. Nyissunk egy új dokumentumot, szúrjuk be a mai dátumot, úgy hogy látható legyen a 

perc, és a másodperc is. Engedélyezzük az automatikus frissítést. Alkalmazzunk a 

dátumra Times New Roman 24-es betűtípust. Mentsük el a dokumentumot 

datumproba.docx név alatt (jegyezzük meg a perc és a másodperc állását), nyissuk meg 

a dokumentumot, és figyeljük meg, hogy van-e eltérés a két időpont között. 

 

Szimbólumok beszúrása 

 

Gyakran fordul elő, hogy olyan karaktereket szeretnénk használni, amely adott 

billentyűkiosztáson nem található meg. A Beszúrás szalag Szimbólum (Insert > 

Symbol) parancsával szimbólumokat, különleges karaktereket és nemzetközi 

karaktereket és szúrhatunk be.  Egy karaktert vagy szimbólumot úgy is beszúrhatunk, ha 

a numerikus billentyűzeten beírjuk a karakter kódját. Ha egy gyakran használt 

szimbólumot gyorsan szeretnénk beszúrni, rendeljünk a szimbólumhoz 

billentyűparancsot a Billentyűparancs (Shortcut Key) gomb segítségével. A Betűtípus 

(Font) cserélésével változik a beszúrható karakterek típusa. 



A Különleges karakterek (Special Characters) fülön egyszerűen 

kiválaszthatunk egyes gyakran használt különleges karaktereket (Euró jel, Copyright 

szimbólum, nyomdai idézőjelek, stb.). Ha valóban gyakran használjuk ezeket a 

szimbólumokat, érdemes lehet megjegyezni a hozzájuk tartozó billentyűkombinációkat.  

 

73. kép 

Szimbólumok  beszúrása 

 

 
 

 

Feladatok: 

1. Szúrjuk be a € © ® æ £ jeleket, színezzük át a jeleket sötétkékre 

2. A Wingdings betűtípusból szúrjunk be olyan szimbólumokat, amelyeket egy 

névjegykártya készítésénél tudunk használni (boríték,  telefon, számítógép, stb.) 

 

Oldaltörés beszúrása 

 

Az oldaltörés gyakorlatilag lezár egy oldalt, a későbbiekben ide nem tud szöveg 

kerülni. Oldaltörést a CTRL + ENTER billentyűkombinációval szúrhatjuk be a 

dokumentumba. Ugyanezt a műveletet hajtja végre a Beszúrás szalag Oldaltörés 

funkciója (Insert > Page Break). Ha törölni kívánjuk a töréspontot, akkor jelöljük ki a 

törölni kívánt szakasztörést vagy oldaltörést, és nyomjuk meg a DELETE billentyűt 

(ajánlott a vezérlő karakterek megjelenítése).  

A további töréspontok a Lap elrendezés (Page Layout) szalag Töréspontok 

(Breaks) legördülő menüjében találhatók. 

 

 

 

 

 



74. kép 

Töréspontok beszúrása 

 

 

 
 

 

Feladatok: 

1. Szúrjuk be töréspontot az EvesJelentes.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)  dokumentumba, a kezdőlap, és a 

tartalomjegyzék után, valamint a főcímek után. 

 

Hasábok beszúrása 

 

A Word alapértelmezetten egy hasábba rendezi el a begépelt szöveget. Ha ezen 

változtatni szeretnénk, jelöljük ki a megfelelő szövegrészt. Ezután klikkeljünk  a Lap 

elrendezése szalag Hasábok  (Page Layout > Columns) parancsára. A legördülő 

menüből kiválaszthatjuk a hasábokat, sablon alapján, illetve a További hasábok (More 

Columns) menüpont alatt egyéni hasábokat is be tudunk állítani. 

 

 

 

 

 

 

 

 

 



75. kép 

Hasábok panel 

 

 
 

Lábjegyzetek és végjegyzetek beszúrása 

 

Lábjegyzetek és végjegyzet segítségével további magyarázatot fűzhetünk a 

szövegben szereplő szavakhoz (irodalmi hivatkozás, kiegészítés, stb.). A végjegyzet a 

dokumentum legvégére kerül (oda, ahol a szöveg véget ér), egy végjegyzet van egy 

dokumentumban. Lábjegyzet minden oldal alján megtalálható, amelyen létrehozzuk. 

A lábjegyzetek és végjegyzetek beszúrása a Hivatkozások (References) szalagról 

történik. A megfelelő szó után klikkelve (amely után a hivatkozást szeretnénk felvenni) 

klikkelünk a Lábjegyzet beszúrása (Insert Footnote), illetve a Végjegyzet beszúrása 

(Insert Endnote) parancsra. Ezután hivatkozások szövegének begépelése következik. 

 

76. kép 

Lábjegyzetet és végjegyzetek beszúrása 

 

 
 

 

Egyre gyakrabban használunk hivatkozásként internetes hivatkozásokat. Ha olyan 

szöveget gépelünk be, amelyben megtalálható az e-mail címre, illetve webcímre utaló 

karakter vagy karaktersor (@, .com, www.), akkor a Word ezt a szöveget hivatkozásként 

jeleníti meg (kék szín, aláhúzott szöveg).  Erre a szövegre Control tartása mellett 



klikkelünk, akkor az alapértelmezett böngészőben megnyílik a honlap, illetve 

levelezőprogramban az e-mail cím. A tartalomjegyzék elemei is hivatkozásként jelennek 

meg. 

A hivatkozások sajátos helyi menüvel rendelkeznek, amelyből különböző 

műveletet kezdeményezhetünk, például megszüntethetjük, a Hivatkozás eltávolítása 

(Remove Hyperlink) opcióval. 

 

Feladatok: 

1. A Bill Gates.doc dokumentumba (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából) szúrjunk be a következő végjegyzetet 

a főcím után: Forrás: www.hu.wikipedia.com 

2. Szúrjunk be egy lábjegyzetet az első bekezdésben a „1995 és 2008 közöt” szöveg után, 

a következő szöveggel: Ma a harmadik leggazdagabb ember 

3. Alkalmazzunk lábjegyzeteket és végjegyzeteket Szovegformazas/Labjegyzetek.doc  

dokumentumban, a minta alapján. 

 

Élőfej és élőláb 

 

Az Élőfej (Header) és Élőláb (Footer) a Beszúrás szalagról jeleníthető meg 

(sablon és egyéni). A beszúrás után ezek az elemek szerkeszthetők a Tervezés (Design) 

szalagról. Szerkesztésük megegyezik a hagyományos szöveg szerkesztésével. 

Létrehozásuk után és nyomtatásba halványabb színt vesznek fel. 

 

Feladatok: 

1. Készítsünk memorandumot egy tetszőleges szervezet számára (név, cím telefonszám, 

fax, web, mail). A kétnyelvű memorandum közepére szúrjuk be a 

Grb_SuboticaResize.jpg (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából)   címert, szürke árnyalatban. A 

memorandum lábjegyzetébe szúrjuk be a mai dátumot. Mentsük el a memorandumot 

sablonként (a memorandum célszerű ha 3 oszlopú táblázatba kerül). 

 

Nyelvi ellenőrzés 

 

A nyelvi ellenőrzés első lépéseként a dokumentum nyelvének a meghatározását 

kell elvégeznünk. Amely a szövegrész vagy teljes szöveg kijelölése után a státuszsorról 

érhető el a legegyszerűbben (a módosítani kívánt nyelvre klikkelve). 

 

 

 

 

 

 

 

 



77. kép 

A dokumentum nyelvének meghatározása 

 

 
 

A Word biztosít egy olyan eszközt, amely automatikusan leellenőrzi szövegünk 

helyesírását, és lehetőséget ad arra is, hogy a hibákat kijavítsuk. Ezt a funkciót a 

Korrektúra szalag  Helyesírás (Review > Spelling & Grammar) menüpontjával tudjuk 

megjeleníteni (gyorsgomb F7). Ezután megjelenik egy párbeszédablak, amelyik a 

felmerülő hibákat megmutatja, és lehetőséget ad arra, hogy a gép által esetleg felajánlott 

javítási lehetőségek valamelyikét elfogadjuk, vagy saját magunk javítsuk ki a hibás szót.  

A helyesírás ellenőrzése azonban szövegösszefüggést nem vizsgál. Hibákat hagyhat a 

szövegben, ha az elgépelt szó önmagában is értelmes.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



78. kép 

Nyelvi ellenőrzés 

 

 

 
 

Feladatok: 

1. Próbáljuk ki a nyelvi ellenőrzést tetszőleges magyar szavakon 

2. Futtasunk angol nyelvű ellenőrzést az ellenorizni.doc (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes/Szovegformazas vagy a 

D:/ECDL/MODUL3/Szovegformazas mappából) dokumentumban   

 

Nyomtatás 

 

A nyomtatást a Fájl menü Nyomtatás (File > Print) parancsával, vagy a 

CTRL+P billentyűkombinációval kezdeményezhetjük. Ezután megjelenik egy 

párbeszédablak, amelyben Példányszám (Copies) mezőnél megadhatjuk azt, hogy hány 

példányban szeretnénk kinyomtatni a dokumentumot. Ha több nyomtató van a gépünkre 

(hálózatra) telepítve, akkor ezt ki tudjuk választani, illetve Nyomtatóbeállításokat 

(Printer Properties) módosíthatjuk. Abban az esetben, ha a számítógépünkhöz nincs 

csatlakoztatva nyomtató, akkor a Nyomtatás fájlba (Print to file) lehetőséget 

engedélyezzük. Ilyenkor, az OK gomb lenyomása után, egy fájlot hozunk létre (a hely és 

a név megadása után), amely tartalmazza a dokumentumot, valamint a nyomtatáshoz 

szükséges beállításokat. Ez az opció a nyomtatók legördülő menü alján található meg. 

A Beállítások (Settings) résznél a nyomtatási tartományra vonatkozó 

beállításokat tudjuk elvégezni (mely oldalakat nyomtassuk). Az Összes oldal 

nyomtatása (Print All Pages) legördülő menüből választhatjuk például az Aktuális 

oldal nyomtatása (Print Current Pages). Az Oldalak (Pages) mezőnél konkrét 

oldaltartományokat tudunk megadni (például: 3,6 vagy 4-8 illetve a 1,3, 5-7). A 



Nyomtatás (Print) ikonra klikkelve kezdeményezzük a nyomtatást a beállított 

paraméterek alapján. 

 

78. kép 

Nyomtatás 

 

 
 

 

 

 

Feladatok: 

1. Nyomtassuk ki az EvesJelentes.doc dokumentum szövegét (a 

C:/+Tanitokepzo/InformatikaAlapjai/Szovegszerkesztes vagy a D:/ECDL/MODUL3 

mappából). Ha nincs erre lehetőségünk, akkor nyomtassuk fájlba a dokumentumot. 

 

 

 

 

 

 

 



Technikai jellegű hibák a szövegben 

 

A szöveg begépelésekor számos technikai jellegű hiba adódhat. Az egyik 

leggyakrabban jelentkező ilyen hiba a több helyköz vagy a helyköz rossz helyre történő 

begépelése. A következő táblázat ezeket a hibákat szemlélteti. 

 

11. táblázat 

A nem megfelelő helyközök alkalmazása 

 

Helytelen Helyes 

szó1····szó2 szó1·szó2 

szó1·.szó2 szó1.·szó2 

szó1·,szó2 szó1,·szó2 

szó1·?szó2 szó1?·szó2 

szó1·(szó2) szó1(szó2) 

(·szó1·) (szó1) 

 

Gyakori hibaként jelentkezik a o, illetve az O (kis és nagy o betű) begépelése 0 

(nulla) karakter helyett. A két karakter kinézete (sem) azonos, felcserélésük hibának 

számít.  

Nem megfelelő módon létrehozott horizontális és vertikális távolságok 

létrehozása a dokumentumban is formázási hibának számítanak. A horizontális 

távolságokat behúzással vagy tabulátor segítségével hozzuk létre (több helyköz írása 

hiba). A vertikális távolságokat Térköz (Indent) felvételével hozzuk létre, több Enter 

lenyomása szintén hibának számít. 

 

 

 


